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Getting help and support Related documentation

Related documentation

The following manuals are available as part of the TekExpress SFP-TX Compliance and Debug Solution
documentation set.

Table 1: Product documentation

Item Purpose Location
Online Help In-depth operation and Ul help

PDF of the Online Help In-depth operation and Ul help

E: +  www Tektronix.com

See also

B Technical Support (see page 2)

Conventions used in help

Online Help uses the following conventions:
®  The term “DUT” is an abbreviation for Device Under Test.

®  The term “select” is a generic term that applies to the two mechanical methods of choosing an option:
using a mouse or using the touch screen.

TekExpress SFP-TX Compliance and Debug Solution 1



Getting help and support Technical support

Technical support

Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or comments on your application or oscilloscope. Contact Tektronix through mail,
telephone, or the Web site. See Contacting Tektronix for more information.

When you contact Tektronix Technical Support, please include the following information (be as specific as
possible):

General information

All instrument model numbers

Hardware options, if any

Probes used

Your name, company, mailing address, phone number, FAX number

Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information

Software version number
Description of the problem such that technical support can duplicate the problem
If possible, save the setup files for all the instruments used and the application

If possible, save the TekExpress setup files, log.xml, *.TekX (session files and folders), and status
messages text file

If possible, save the waveform on which you are performing the measurement as a .wfm file

TekExpress SFP-TX Compliance and Debug Solution



Getting started Tektronix oscilloscope compatibility

Tektronix oscilloscope compatibility

The TekExpress SFP-TX application runs on the following Tektronix oscilloscopes:

NOTE. The Host Output TWDPc Measurement is supported only on oscilloscopes that support 100 Gs/s.
For example, DPO/DSA/MSO71604C and DPO/DSA/MSO72004C Series Digital Oscilloscopes.

®  DPO/DSA71604 and DPO/DSA72004 Series Digital Oscilloscopes

= DPO/DSA71604B and DPO/DSA72004B Series Digital Oscilloscopes

B DPO/DSA/MS071604C and DPO/DSA/MS0O72004C Series Digital Oscilloscopes
B MSO71604 and MSO72004 Series Mixed Signal Oscilloscopes

= DPO/DSA72504D and DPO/DSA73304D Series Digital Oscilloscopes

See also

B Minimum System Requirements (see page 3)

Minimum system requirements

The following table shows the minimum system requirements needed for an oscilloscope to run
TekExpress.

Table 2: System requirements

Processor Same as the oscilloscope

Operating System Same as the oscilloscope (Windows XP (32-bit) SP2 and higher; Windows 7
(64-bit only)

Memory Same as the oscilloscope

Hard Disk Same as the oscilloscope

Display Same as the oscilloscope !

Firmware B TekScope 5.3.4 (Windows XP)

m  TekScope 6.4 and later (Windows 7)

TekExpress SFP-TX Compliance and Debug Solution 3
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Table 2: System requirements (cont.)

Minimum system requirements

Software B DPOJET, Jitter and Eye Diagram Analysis Tool, version 5.0.0 or later (for
32-bit) or version 6.0.0 or later (for 64-bit)
= National Instruments LabVIEW Run-time Engine 9.0.1 or later
= National Instruments TestStand Engine 4.2.1
B MathWorks MATLAB Runtime 7.14 2(Windows 7), MATLAB Runtime 7.5
(Windows XP 32-bit)
B Microsoft .NET 4.0 Framework
= Microsoft Excel 2002 or above
®  Microsoft Internet Explorer 6.0 SP1 or later
®  Microsoft Photo Editor 3.0 or equivalent software for viewing image files
B Adobe Reader 7.0 or equivalent software for viewing portable document
format (PDF) files
Other Devices = Microsoft compatible mouse or compatible pointing device
m  Four USB ports (two USB ports minimum)
B PCI-GPIB or equivalent interface for instrument connectivity 3

1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, a sampling oscilloscope), it is recommended
that you connect a secondary monitor, which must be enabled before launching the application.

2 MatLab Runtime Compiler is required for performing the Host Output TWDP test. This test is purchase option SFP-WDP.

3 If TekExpress is installed on a Tektronix oscilloscope, TekExpress will use the virtual GPIB port for communicating with oscilloscope applications. If
external GPIB communication devices such as USB-GPIB-HS or equivalent are used for instrument connectivity, make sure that the Talker Listener
utility is enabled in the GPIB menu of the DPO/DSA oscilloscope. For ease of use, connect to an external (secondary) monitor.

User access control

On Windows 7 instruments set User Access Control settings to Never Notify. To set User Access Control
Settings, go to Control Panel > User Accounts > Change User Access control Settings and set it to Never

Notify as shown in the image.

TekExpress SFP-TX Compliance and Debug Solution



Getting started Install the software

) User Account Control Settings = | 5 ||

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful pregrams from making changes to your computer.
Tell me more about User Account Control settings

Always notify

Never notify me when:

®  Programs try to install software or make changes to
my computer

® Imake changes to Windows settings

‘[:j‘ Not recommended. Choose this only if you need to
use programs that are not certified for Windows 7
- because they do not support User Account Contral.

MNever notify

See also

®  Compatibility (see page 3)

Install the software

The software can be installed on any compatible instrument running Windows XP or Windows 7 (64-bit).
See Minimum System Requirements (see page 3) for details.

1. Close all applications.

2. Go to the www.tek.com Web site and search for SFP-TX to locate the installation file. Download
the file SFP-TXWebInstaller.exe.

3. Double-click the executable file to extract the installation files.
After extraction, the installer launches and the software automatically installs in the following location:
= Windows XP location: C:\Program Files\Tektronix\TekExpress\TekExpress SFP-TX

= Windows 7 location: C:\Program Files (x86)\Tektronix\TekExpress\TekExpress
SFP-TX

See also

B Minimum System Requirements (see page 3)

B Compatibility (see page 3)

TekExpress SFP-TX Compliance and Debug Solution 5



Getting started Activate the license

Activate the license

The SFP-TX application runs in Evaluation mode if you do not provide a valid license key. You are
allowed 10 free trials in Evaluation mode. Each time you open the application without supplying a valid
license key, one of the free trials is used.

An evaluation version of the Host Output TWDPc test (see page 138) is included in the SFP-TX
installation. You are allowed 10 free trials of this test. Each time you run the test, one of the free trials
is used, regardless of how often you open the application. To use this test after the evaluation period,
purchase the SFP-WDP option license key.

Activate the license using the Option Installation wizard on the oscilloscope. Instructions for using the
Options Installation window to activate licenses for installed applications is provided in the oscilloscope
online Help:

1. From the oscilloscope menu bar, click Utilities > Option Installation.
The TekScope Option Installation wizard opens.

2. Press the F1 key on the oscilloscope keyboard to open the Option Installation help topic. Follow the
directions in the topic to activate the license.

See also

B View Version and License Information (see page 7)

6 TekExpress SFP-TX Compliance and Debug Solution



Getting started View version and license information

View version and license information

Use the following instructions to view version information for the application and for the application
modules such as the Programmatic Interface and the Programmatic Interface Client.

To view version information:
1. From the Options menu, select About TekExpress.

2. Click the View Version Details link to check the version numbers of the installed test suites.

Version Details

[=1- Automation Framework
| i TekExpress : 2.0.0.183
Instrument Bench : 1.0.0.0
Email Component : 1.4.6 23260
Programmatic Inteface : 1.4.6.23264
: Programmatic Interface Cliert : 1.4.6.23260
£l Automated Solution

£+ SFP+ Tx
Host : 1.0.0.0
i Module : 1.0.0.0

To view license information:
1. From the oscilloscope Help menu, select About TekScope.
The Options section in the dialog box displays a list of installed options, including SFP-TX.

2. To view the Option key, look in the Option installation key section.

See also

B Activate the License (see page 6)

®  Options Menu (see page 15)
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Getting started SFP-TX application overview

SFP-TX application overview

NOTE. The skew between Data+ and Data- in the signal path from the DUT to the oscilloscope will be
computed and compensated before running the measurements.

TekExpress is the Tektronix Test Automation Framework, developed to support your current and future
test automation needs. TekExpress uses a highly modular architecture that lets you deploy automated test
solutions for various standards in a relatively short time.

Key features

SFP-TX has the following key features:

m  Allows conformance testing to the latest Compliance Test Specification (CTS)

B Reliable Testing:
= Conformance to SFP+ interconnect module electrical testing ensures reliable results
= SFP-TX is SFP+ compliance software.

= Enables execution of the physical-layer (PHY), electrical tests, and SFP+ based electrical
measurements

B Automated testing:
- Minimizes user intervention when conducting time-consuming testing
= Reduces the time required to conduct testing
B Selective testing:
= Performs fully-automated testing for transmitter measurements
= Allows you to select individual tests or test groups in the tree-structure

= Avoids repeated testing through accurate and reliable results from a single run

8 TekExpress SFP-TX Compliance and Debug Solution



Getting started Application directories and usage

B Quick testing:
= One-button selection of multiple tests ensures faster testing.
- Test margins and statistical information aid analysis to find answers quickly.
= One-button csv-format summary and HTML report saves time.
®  Complete Solution:
= Wide range of tests for SFP+ Host devices and SFP+ Module devices enables complete validation

= Complete compliance solution with an elaborate test fixture and signal sources support for SMA
cable-based solution provides cost-effective way to perform compliance testing

B Customize the setup:
= Modify the test setup according to the DUT configuration.
- Run test measurements with different record lengths.
= Run test measurements with more than one signal.
B Detailed test reporting:
- Provides a Pass/Fail summary table
= Provides margin details on each test
= Provides a consolidated report for all tests

- Provides additional information such as skew, and signal type selected for each measurement

Application directories and usage

The application directory and associated files are organized as follows:

AP

Bin

Compliance Suites
Data banager
Data Storage
Docurments
Exarnples

Icp

Lib

Report Generataor
SCP

Toals

TekExpress SFP-TX Compliance and Debug Solution 9



Getting started

10

Application directories and usage

The following table lists the default directory names and their usage.

Table 3: Application directories and usage

Directory names

Usage

InstallDir\TekExpress\TekExpress SFP-Tx

Contains the application and associated files

TekExpress SFP-TX\ACP Contains instrument and SFP-Tx application-specific interface
libraries
TekExpress SFP-Tx\Bin Contains miscellaneous SFP-Tx application libraries

TekExpress SFP-Tx\Compliance Suites

Contains compliance-specific files

TekExpress SFP-Tx\Data Manager

Contains result management-specific libraries of the SFP-Tx
application

TekExpress SFP-Tx\Data Storage

Contains libraries needed for storing data

TekExpress SFP-Tx\Documents

Contains the technical documentation for the SFP-Tx application

TekExpress SFP-Tx\Examples

Contains various support files

TekExpress SFP-TX\ICP Contains instrument and SFP-Tx application-specific interface
libraries

TekExpress SFP-Tx\Lib Contains utility files specific to the SFP-Tx application

TekExpress SFP-Tx\Report Generator Contains Excel Active X interface Library for Report Generation

TekExpress SFP-TX\SCP Contains instrument and SFP-Tx application-specific interface
libraries

TekExpress SFP-Tx\Tools Contains instrument and SFP-Tx application-specific files

See also

B View Test-Related Files (see page 69)
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File name extensions

The TekExpress SFP-TX application uses the following file name extensions:

File name extension Description

TekX Session files are saved in this format but the extensions may not be
displayed.

.seq The test sequence file

xml The encrypted XML file that contains the test-specific configuration
information
The log file extension is also xml.

wfm The test waveform file

.mht Test result reports are saved in this format by default. Test reports can

also be saved in HTML format (see page 56).

See also

®  View Test-Related Files (see page 69)

m  Application Directories and Usage (see page 9)

B Before You Click Start (see page 59)

TekExpress SFP-TX Compliance and Debug Solution 1
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Operating basics Start the application

Start the application

The first time you open the application after installation, you are required to enter a license key. The
application also checks for a file called Resources.xm1 located in the My TekExpress folder. If this file
is not found, the application performs instrument discovery before launching. The Resources.xm] file
contains information regarding instruments that are available on your network.

NOTE. When the application starts, it checks for the appropriate license key. If the valid license key is
not present, the application switches to the Evaluation mode. If the application fails to detect the key, it
continues to run in Evaluation mode. You are allowed 10 free trials in Evaluation mode. Each time you
open the application without supplying a valid license key, one of the free trials is used.

To run the SFP-TX application, do one of the following:
®  From the TekScope Analyze menu, select Analyze > TekExpress SFP+Tx.
B Double-click any saved session file.

While running the application, switch between the oscilloscope screen and SFP-TX by clicking the desired
window or by using the Alt+Tab key combination. To keep the application window on top, select Keep
On Top from the Options menu (see page 15).

NOTE. If the application was not terminated properly during the last use, a dialog box asks to recall the
previously unsaved session.

See also

m  Activate the License (see page 6)

Exit the application

Use the following method to exit the application:

NOTE. Using other methods to exit the application results in abnormal termination of the application.

TekExpress SFP-TX Compliance and Debug Solution 13



Operating basics

1. Click on the application title bar.

2. Do one of the following:

Application controls

= Ifyou have an unsaved session or test setup open, you will be asked to save it before exiting. To
save it, click Yes. Otherwise click No. The application closes.

= A message box appears asking if you really want to exit TekExpress. To exit, click Yes.

Application controls

14

Table 4: Application controls descriptions

ltem

Description

Options menu (see page 15)

Opens the Options menu for access to global controls

Panels (see page 19)

Visual frames with sets of related options

Command buttons

Buttons that initiate an immediate action such as the Start,
Stop, Pause, Continue, and Clear command buttons

Start button

Use the Start button to continuously acquire and accumulate
measurements. If prior acquired measurements have not
been cleared, the new measurements are added to the
existing set.

Stop button

Stop

@

Use the Stop button to abort the test.

Pause \ Continue button

Pause Continue

oy

Use the Pause button to temporarily interrupt the current
acquisition. When a test is paused, the button name
changes to “Continue.”

TekExpress SFP-TX Compliance and Debug Solution
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Options menu

Table 4: Application controls descriptions (cont.)

Item

Description

Clear button

Clear

Use the Clear button to clear all existing measurement
results. Adding or deleting a measurement, or changing a
configuration parameter of an existing measurement, also
clears measurements. This is to prevent the accumulation
of measurement statistics or sets of statistics that are not
coherent. This button is available only on the Results panel

(see page 28).

Application window move icon

Place the cursor over the three-dot pattern in the upper left
corner of the application window. When the cursor changes
to a hand, drag the window to the desired location.

Options menu

The Options menu is located in the upper right corner of the application.

The Options menu (see page 16) has the following selections:

Menu Function

Default Test Setup Opens an untitled test setup with defaults selected
Open Test Setup Opens a saved test setup

Save Test Setup Saves the current test setup selections

Save Test Setup As Creates a new test setup based on an existing one

Open Recent

Displays a menu of recently opened test setups to select from

Instrument Control Settings (see page 18)

Shows the list of instruments connected to the test setup and allows
you to locate and refresh connections to those instruments

Keep On Top

Keeps the TekExpress SFP-TX utility on top of other open windows
on the desktop

Email Settings (see page 17)

Use to configure email options for test run and results notifications

Deskew (see page 158)

Use to deskew channels

TekExpress SFP-TX Compliance and Debug Solution
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16

Options menu

Menu Function
Help Displays TekExpress Help
About TekExpress B Displays application details such as software name, version

number, and copyright

B Provides access to license information (see page 7) for your

SFP-TX installation

B Provides a link to the Tektronix Web site

Options menu

Default Test Setup
Open Test Setup
Save Test Setup
Save Test Setup As
Open Recent

Instrument Control Settings
Keep On Top

Email Settings

Deskew...

Help
About TekExpress

See also

B Application Controls (see page 14)

TekExpress SFP-TX Compliance and Debug Solution
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Email settings

Use the Email Settings utility to configure email notifications (see page 55) if you want to receive
notifications when a test completes, produces an error, or fails. Select the type of test session information
to include in the notification, such as test reports and test logs, the email message format, and the email

message size limit.

NOTE. Recipient email address, senders address, and SMTP Server are mandatory fields.
The ScoreCard and Ayalysis Screenshot options are not available in SFP-TX.

See also

® Options Menu (see page 15)

m  Select Test Notification Preferences (see page 56)

TekExpress SFP-TX Compliance and Debug Solution 17
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Instrument control settings

18

The Instrument Control Settings dialog box shows the list of resources found on different connections. It
serves two purposes:

®  Discovers the connected instruments

B Confirms the instrument connection setup

_TekExpress Instrument Control Se

—
October 05. 2011 13:43:41 f )

Use the Instrument Control Settings feature to search for connected instruments (see page 40) and view
instrument connection details. Connected instruments displayed here can be selected for use under Global
Settings in the test configuration section. See step 2 of Configure Tests (see page 51) for details.

See also

B Options Menu (see page 15)
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About panels

TekExpress SFP-TX has the following main panels:

Table 5: Application panels

Panel Name Purpose

Setup (see page 19) The Setup panel allows you to configure the test setup. Use this panel to:

B Select device parameters (see page 43).

m  Select the test(s) (see page 44).

B Select acquisitions parameters (see page 46) for selected tests.

m  Configure the selected tests (see page 51).

B Select test notification preferences (see page 56).

Status (see page 26) View the acquisition and analysis status of the selected tests, and view test logs.

Results (see View a summary of test results and select result viewing preferences.

page 28)

Reports (see Browse for reports, save reports, specify report naming conventions, select content to include
page 29) (such as summary information, detailed information, user comments, plot images, setup
configuration), and select other report viewing options.

See also

B Application Controls (see page 14)

Setup panel

The Setup panel has numbered tabs to guide you through the test setup process:

1 — DUT (see page 21), 2 — Test Selection (see page 22), 3 — Acquisitions (see page 23), 4 — Configuration

(see page 24), and 5 — Preferences (see page 25)

By default, only the DUT, Test Selection, Acquisitions, and Preferences tabs are displayed. The

Configuration tab is only available if you select the Advanced View (see page 20) option in the DUT tab.
Otherwise, configuration settings for tests are available from the Configure button on the Test Selection tab.

Options selected in a preceding tab affect options available in the next tab down. However, you can switch

between the tabs in any order if you need to modify test parameters. For more information on using the

Setup panel, see Test Setup Overview (see page 42).

When you finish making selections in a tab and move to the next tab, the number in the tab title changes to

a check mark. If you make changes on a tab that significantly affect the settings set in a preceding tab,
the check mark in the tab title of the affected tab is replaced with the number again to indicate that you

should check the settings on that tab.

TekExpress SFP-TX Compliance and Debug Solution
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See also

B About Panels (see page 19)

B Select Device Parameters (see page 43)

B Sclect a Test (see page 44)

B Select Acquisitions (see page 46)

B Configure Tests (see page 51)

m Select Test Notification Preferences (see page 56)

DUT tab, advanced view

DUTID DUTOOM

@ Acguire live waveforms O Use pre-recarded waveform files

Version |SFF-8431 Revision4.1 |V |

Device Prefile

(+) Host ) Module

10GSFP+Cu Direct Attach Cable
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Setup panel

DUT tab, compliance view

DUTID DUTDO

@ Acquire live waveforms O Use pre-recorded waveform files

Viw |Compiince | |

Version |SFF-B431 Revision 4.1 | ¥ |

Device Profile

{+) Host | Module

10GSFP+Cu Direct Attach Cable

TekExpress SFP-TX Compliance and Debug Solution
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Setup panel

Test Selection tab, host profile tests

SFP+ Tx : Host : SFF-8431 Revision 4.1

L=_|-- SFF-8431 Table 11 Output Electrical Specifications at B
Single Ended Cutput Voltage Range
Output AC Common Mode voltage (RMS)
IZ—ZI{_I—_| SFF-8431 Table 12 Jitter and Eye Mask Specifications at B
D Crosstalk Source Rise/Fall Time (20%-80%)
D Crosstalk Source Amplitude (p-p Differential)
Signal Rise/Fall Time (20%-50%)
Total Jitter
Data Dependent Jitter
Data Dependent Pulse Width Shrinkage

-[w] Uncorrelated Jitter
Transmitter Q=g
--{v| Eye Mask Hit Ratio
= SFF-8431 Table 33 Output Specifications at B for Cu
Yoltage Modulation Amplitude (p-p)

2] Temmoenitne Aimm fne S

Test Description

DD is the range (max - min) of the timing -
variations measured on the Differential Signal B
with a crossing level equal to the average value

of the entire waveform being measured. The

waveform is averaged sufficiently to remove the
o
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Setup panel

Acquisitions tab, host profile

SFP+ Tx : Host : SFF-8431 Revision 4.1

Data Source (+#) Data Source (-)

CH1 v | |CH3 |v | ﬁ

 Acquisition
- Data Dependent Jitter Data Dependent Jitter Acquisition
Data Dependent Pulse Width Shrinkag Data Dependent Pulse Width Shrinks
1 Eye Mask Hit Ratio Eye Mask Hit Ratio Acquisition

Output AC Common Mode voltage (RME Output AC Common Mode voltage (R
Cutput AC Common Mode voltage (RM: Output AC Common Mode voltage (R
Signal Rise/Fall Time (20%-30%) Signal Rise/Fall Time (20%-80%) Ac
Single Ended Output Voltage Range  Single Ended Output Yoltage Range
Total Jitter Total Jitter Acquisition
Transmitter Q=q (for Cu) Transmitter Qsq (for Cu) Acquisition
Transmitter Qisq Transmitter Qsq Acquisition

aUncorrelaﬂed Jitter Uncorrelated Jitter Aciuisition a@

Acquisition and Save Options I- I A ire P e
|| Save All Waveforms Before Analysis
| Analyze Immediately - No Waveforms Saved

(+) Save and Analyze Acquisition In Sequence  Sianal Validation
|Pr0mpt me if signal f... | A |

TekExpress SFP-TX Compliance and Debug Solution
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Configuration tab, measurements (advanced view)

{+) Compliance Mode | User Defined Mode

S

Single Ended Cutput Voltage Range
Qutput AC Common Mode voltage (RMS)
[=)- SFF-8431 Table 12 Jitter and Eye Mask Specffications at B
- Signal Rise/Fall Time (20%-80%)
- Total Jitter
-Data Dependent Jitter
-Data Dependent Pulse Width Shrinkage
- Uncomelated Jitter
L Transmitter Qsg
i... Fun Mask Hit Ratin

Presst ||
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Preferences tab

[— On Test Failure, pause the test and let me investigate

[ OnTest Failure, stop and notify me of the failure ﬁ
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Status panel

Use the Status panel to track test measurement progress. The Status panel has two tabs: the Test Status
(see page 27) tab displays the acquire status and the analysis status of the tests as they are being executed;
the Log View tab (shown below) displays a view of the test log.

For more information on using the Status panel, see View the Progress of Analysis (see page 63).

Initializing run time environment. Thiz might take some time.

B/28/2011 4:55:18 PM:
E/28/2011 4:55:18 PM:
B/28/2011 4:55:18 PM::
B/28/2011 4:55:18 PM::
E/28/2011 4:55:19 PM::
E428/2011 4:85:20 PM:
E428/2011 4:55:20 PM::
B/28/2011 4:55:20 PM::
B/28/2011 4:55:20 PM::
B/28/2011 4:55:20 PM::
B/28/2011 4:55:20 PM::
E/28/2011 4:55:20 PM::
E428/2011 4:85:21 PM:
E428/2011 4:85:21 PM:
B/28/2011 4:55:21 PM:
B/28/2011 4:55:21 P
B/28/2011 4:55:21 PM::
E/28/2011 4:55:21 PM:
E428/2011 4:85:25 PM:
E428/2011 4:55:25 PM::
B/28/2011 4:55:25 PM::
E/28/2011 4:55:26 PM:
B/28/2011 4:55:26 PM::
B/28/2011 4:55:26 PM::
E/28/2011 4:55:26 PM::
E428/2011 4:55:28 PM:
E428/2011 4:55:29 PM::
R/2R52M11 A-RR-29 Phd--

Test execution starked

Searching for parameter: Mumber of retries for instrument |0 emors

Found. *alue is: 3
Searching for parameter: Time between retries [seconds)
Found. Walue is: 20
Searching for parameter: Real Time Scope
Found. Walue iz: GPIBB:12INSTR
Searching for parameter: DP Connected to
Found. ¥alue is: CHZ2
Searching for parameter: DN Connected to
Found. *alue is: CH4
Searching for parameter: Direct Attached Cable Cu
Found. Walue is: Enabled
Searching for parameter: Frompt me if Measurement failz
Found. ¥alue is: Enabled
Searching for parameter: Signal Y alidation
Found. Yalue iz Prompt me if signal fails
Setting "LabVIEW adapter” to Lab/IEWW RTE +3.0
Searching for parameter: Acquisition S ave O ptions
Found. Walue iz: Save and Analyze Acquisitions |n Sequence
Searching for parameter: Signal Validation
Found. “alue is: Prompt me if signal failz
Searching for parameter: Record Lenagth
Found. Yalue is: 266
Switching to analyze tab
Searching for parameter: On Failure Pauze
Found. Walue is: True
Searrhinn for narametar N Failre Stanand Matifn
i’

Status Ready |

See also

®  About Panels (see page 19)

26
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Test Status view

-Vﬁ TekExpres 6

| Test Name | Acquisition | Acquire Status | Analysis Status
a
Crosstalk Source Amplt... Crosstalk Source Amplitude . Completed Acquisition Completed

Crozstalk Source RizesF... Crosstalk Source RizefFall Ti... Completed Acouisition Completed
Diata Dependent Jitter Diata Dependent Jitter Acqui... Completed Acouisition Completed
Data Dependent Pulse .. Data Dependent Pulse Width... Completed Acouisition Completed
Eye Mazk Hit Ratio Eye Mask Hit Ratio Acquisition  Completed Acquisition Completed
Cutput AC Common Mod... Output AC Common Mode v, Completed Acguisition Completed
Cutput AC Cotnimon Mod... Output AC Common Mode v, Completed Acguisition Completed
Signal RizefFall Time (20... Signal RizeFall Time (20%-5... Completed Acouisition Completed
Single Ended Cutput Yol Single Ended Output Yoltage... Completed Acquisition Completed
Total Jitter Total Jitter Acquisition Completed Acouisition Completed
Transmitter =g (for Cu)  Transmitter Geg (for Cu) Ac... Completed Acouisition Completed
Transmitter Gz Tranzmitter Qg Acquistion  Completed Acquisition Completed
Uncorrelated Jiter Uncorrelsted Jitter Acquisition  Completed Acquisition Completed
Waltage Modulstion Ampl... Voltage Modulstion Amplitud... Completed Acguisition Completed

Status Ready |
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Results panel

28

Results panel

When a test completes, the application switches to the Results panel to display a summary of test results.

NOTE. Results of Crosstalk measurements are not included in the overall test results because these

measurements are informative only.

Set viewing preferences for this panel from the Preferences menu in the upper right corner. Viewing
preferences include showing whether a test passed or failed, summary results or detailed results, and
enabling wordwrap. For information on using this panel, see View Test Results (see page 64).

See also

Data Dependent Jitter

High Limit
Low Limit

Data
Dependent
Jitter (UI)

Signal - PRBS9

Data Dependent Pulse Width
Shrinkage

Data
Dependent
Pulse Width
Shrinkage (UI)

High Limit
Low Limit

4 Pass
NA

Eye Mask Hit Ratio
(3]

QOutput AC Common Mode
voltage (RMS)
(&3]

QOutput AC Common Mode
voltage (RMS) (for Cu}

[E5]

Signal Rise/Fall Time
{20%-80%)

3]

®  About Panels (see page 19)

Eye Mask Hit
Ratio Signal -
PRBS31
Output AC
Commonmode
voltage (m\)
Signal -
PRBS31
Qutput AC
Commonmode
voltage Cu
{mV) Signal -
PRBS31

Signal Rise
Time (pS) ,
Signal Fall

& Pass

8.8320 mv

8.8329 mv

52,1088 pS
A9.5017 pS

18.1088 , 15.5017

[~
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Reports panel

Use the Reports panel to browse for reports, name and save reports, select report content to include, and
select report viewing options.

For information on setting up reports, see Select Report Options (see page 56). For information on viewing
reports, see View the Report (see page 65).

Web Archive (*.mht;* . mhtml}

See also

®  About Panels (see page 19)
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Saving and recalling test setups About test setups

About test setups

TekExpress SFP-TX opens with the default setup selected. Run a test before or after saving a setup. When
you save a setup, the test information, such as the selected oscilloscope, general parameters, acquisition
parameters, measurement limits, waveforms (if applicable), and other configuration settings are all saved
under the setup name. Use test setups to:

B Run a saved test in prerecorded mode (see page 62).

®m  View all the information associated with a saved test, including the log file, the history of the test status
as it executed, and the results summary. For details, see Recall a Saved Test Setup (see page 32).

m  Create a new test setup based on an existing one (see page 32).

See also

E  About Setting Up Tests (see page 33)

m  Save a Test Setup (see page 31)

B Recall a Saved Test Setup (see page 32)

Save a test setup

Save a test setup before or after running a test using the parameters you want saved. Create a new test
setup from any open setup or from the default setup. When you select the default test setup, all parameters
are returned to their defaults.

The following instructions start from the default test setup:

1.

N

From the Options menu, select Default Test Setup.
Select the desired options in the Setup panel.

Select the desired report options (see page 56).

If desired, run the test to be sure that it captures the desired information. If it does not, edit the
parameters.

From the Options menu, select Save Test Setup.

See also

m  About Setting Up Tests (see page 33)

m  Test Setup Overview (see page 42)

B View Test-Related Files (see page 69)
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Recall a saved test setup

These instructions are for recalling saved test setups.

1.
2.

From the Options menu, select Open Test Setup.

In the File Open dialog box, select the desired setup from the list and then click Open.

See also

About Test Setups (see page 31)

Create a New Test Setup Based on an Existing One (see page 32)

Create a new test setup based on an existing one

32

Use this method to create a variation on a test setup without having to create the setup from the beginning.

1.

LI S

From the Options menu, select Open Test Setup.

In the File Open dialog box, select the desired setup from the list and then click Open.
Modify the parameters as desired.

From the Options menu, select Save Test Setup As.

In the File Save As dialog box, enter a test setup name and then click Save.

See also

About Test Setups (see page 31)

Select Device Parameters (see page 43)

Configure Tests (see page 51)

Select Acquisitions (see page 46)
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About setting up tests

Set up tests using the tabs in the Setup panel (see page 19). Settings in the DUT tab use a top-down,
left-to-right logic flow, so that any parameter that affects or acts as a filter for other parameters appears
either above or to the left of the affected parameters.

Test options: views and modes

Test options include two views, Compliance and Advanced (selected in the DUT tab of the Setup panel),
and two modes, Compliance and User Defined (selected in the configuration settings of the Setup panel).
The selected view determines where the test configuration settings are displayed. The selected mode
determines whether you can change test configuration settings to include those that are noncompliant.

= Compliance View selected with Compliance Mode

View configuration options in the Test Selection tab of the Setup panel. Tests will run automatically
with little or no user intervention. You will not be able to change test parameters to anything that
deviates from the compliance standards. The only test configuration parameters that you can change
in this mode are the Global Settings.

®  Compliance View selected with User-Defined Mode

View configuration options in the Test Selection tab of the Setup panel. Tests will run automatically
but you will be able to change the parameters before starting the tests.

m  Advanced View selected with Compliance Mode

View configuration options in the Configuration tab of the Setup panel. Tests will run automatically
with little or no user intervention. You will not be able to change test parameters to anything that
deviates from the compliance standards. The only configuration parameters that you can change

in this mode are the Global Settings.

®  Advanced View selected with User-Defined Mode

View configuration options in the Configuration tab of the Setup panel. Tests will run automatically
but you will be able to change test parameters before starting the tests.

Supported tests

The application supports the following tests, grouped by profile.
Host Profile Tests

m  SFF-8431 Table 11 Output Electrical Specifications at B:

= Single Ended Output Voltage Range (see page 115)

= Output AC Common Mode voltage (RMS) (see page 116)
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m  SFF-8431 Table 12 Jitter and Eye Mask Specifications at B:

Crosstalk Source Rise/Fall Time (20%—80%) (see page 117)

Crosstalk Source Amplitude (p-p Differential) (see page 118)

Signal Rise/Fall Time (20%—80%) (see page 120)

Total Jitter (see page 121)

Data Dependent Jitter (see page 124)

Data Dependent Pulse Width Shrinkage (see page 126)

Uncorrelated Jitter (see page 128)

Transmitter Qsq (see page 129)

Eye Mask Hit Ratio (see page 131)

B SFF-8431 Table 33 Output Specifications at B for Cu:

NOTE. The group SFF-8431 Table 33 Output Specifications at B for Cu is associated with the 10GSFP+
Cu Direct Attach Cable device profile (the check box for this profile is located on the DUT tab of the Setup
panel). This group of tests is available only when this check box is selected.

Voltage Modulation Amplitude (p-p) (see page 134)

Transmitter Qsq (for Cu) (see page 135)

Output AC Common Mode voltage (RMS) (for Cu) (see page 137)

Host Output TWDPc (see page 138)

NOTE. An evaluation version of the Host Output TWDPc test is included in the SFP-TX installation.
You are allowed 10 free trials of this test. Each time you run the test, regardless of how often you open
the application, one of the free trials is used. To use this test after the evaluation period, purchase the
SFP-WDP option license key.

Module Profile Tests

m  SFF-8431 Table 16 Transmitter Input Electrical Specifications at B:

34

AC Common-Mode Voltage Tolerance (see page 139)

Single-Ended Input Voltage Tolerance (see page 140)
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m  SFF-8431 Table 17 Transmitter Input Tolerance Signal Calibrated at B:

Crosstalk Source Rise/Fall Time (20%-80%) (see page 141)

Crosstalk Source Amplitude (p-p Differential) (see page 143)

Output AC Common-Mode Voltage (RMS) (see page 145)

Total Jitter (see page 146)

Data Dependent Jitter (see page 148)

Data Dependent Pulse Width Shrinkage (see page 150)

Uncorrelated Jitter (see page 152)

Eye Mask Hit Ratio (see page 153)

See also

B Test Setup Overview (see page 42)

m  Before You Click Start (see page 59)

m  About Test Setups (see page 31)
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Equipment connection setup

To run tests, you need the following equipment (for details, see Minimum System Requirements (see
page 3)):

m A supported Tektronix oscilloscope (see page 3)

B The device under test

= SFP+ fixtures

Table 6: SFP+ fixtures

Tektronix

nomenclature Description

TF-SFP-TPA-HCB-P SFP+ Host Compliance Board Plug
TF-SFP-TPA-MCB-R SFP+ Module Compliance Board Receptacle

TF-SF-TPA-PR SFP+ Host Compliance Board Plug and Module Compliance Board Receptacle

TF-SFP-TPA- SFP+ Host Compliance Board Plug Kit with DC Blocks and Termination

HCB-PK

TF-SFP-TPA- SFP+ Module Compliance Board Receptacle Kit with DC Block and Termination

MCB-RK

TF-SFP-TPA-PRK SFP+ Host Module Compliance Board and Module Compliance Board with DC Blocks and
Termination

Equipment connections can vary by Device Profile (Host and Module) and by individual test. Refer to the
following connection diagrams when setting up equipment for testing.

Connection setup for Host tests

m  Table 12 Crosstalk Source tests
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Digital Oscilloscope

O§ ¢ leze Crosstalk Source
U&rles
T o o O O
ODoO0oD
O
EEFEREEE
Sy B A
T T
Connector
RX- !iiii\J 11
- : s ||”
Rx+ | .
| Host Compliance Board
Stressed Tx+ L Measurement
Signal —H, ’:: R ”|_ Instrumentation
_|I ,:| = Il_
Generator Tx- ] or 2x50 ©
Module Compliance Board

0590-002

= All other Host tests
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Digital Oscilloscope

—
O<° S lgE
..o g5
O85lss
AO _O .O AO
0 00O
SEEFEEE
7 1 1 LJ
Crosstalk —>
Crosstalk Source
C+ve|
G_E-v
e
SFP+ HCB e
KEarwn
\M‘ — DCBlocks

0590001

Test setup for all measurements other than single-ended output voltage range

Digital Oscilloscope

o giffo

Q"o Oomwo mo

(Olooo

Qo g 6d000

O o 1

ol el

T (oo dle O O18

Crosstalk Source — 2
o
O | Crosstalk —» \
12 db
attenuators
[~ ] C+ve
C,
= C-ve
SFP+ HCB B+ve
= B
[ Gr===
DUT

Test setup for single ended output voltage range measurement on DPO/DSA70000D series oscilloscopes
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Digital Oscilloscope

O2 2jes
O80lss
50505
Crosstalk Source “%DD E R & ELE‘
o
O | Crosstalk —»
[~ ] C+ve
C,
= C-ve
SFP+ HCB Bve
= B
[ Gr===
DUT

Test setup for single ended output voltage range measurement on all oscilloscopes other than DPO/DSA70000D
series oscilloscopes

Connection setup for module tests

B Single-Ended Input Voltage Tolerance Test

o Connector
~_ /N % < >~
Measurement /" T length | | Module Under fest | | Input/Output
Instrumentation ’l_ | line
=T
%B” - TN
Module Compliance Board

0E80-004

B All other Module tests
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) Connector

2x50 Q or C L |
Scope - | Crosstalk source

-« | |
Trace length | Host Compliance Board | p-
Stressed g ! B Measurement
gzlrggretlcl)r >l = Instrumentation
Module Compliance Board
0580003
See also

m View Connected Instruments (see page 40)

B About Setting Up Tests (see page 33)

m  Oscilloscope Setup (see page 111)

View connected instruments

40

Use the Instrument Control Settings dialog box to view or search for connected instruments required for
the tests. The application uses TekVISA to discover the connected instruments.

To refresh the list of connected instruments:

1.
2.

From the Options menu, select Instrument Control Settings.

In the Search Criteria section of the Instrument Control Settings dialog box, select the connection
types of the instruments to search for. By default, only the GPIB resource type is selected but you can
select as many types as your system and setup use.

Instrument search is based on the VISA layer but different connected cables determine the resource
type, such as LAN, GPIB, USB. For example, if you choose LAN, the search will include all the
instruments supported by TekExpress that are communicating over the LAN. If the search does not
find any instruments that match a selected resource type, a message appears telling you that no such
instruments were found. If you selected more than one resource type for the search, after you close the
message window, the application will continue searching for the other selected types.

Click Refresh. TekExpress searches for connected instruments.

After discovery, the dialog box lists the instrument-related details based on the selected search criteria.
For example, if you selected LAN and GPIB as the search criteria, the application checks for the
availability of instruments over LAN, then GPIB.
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ME070EDS CHRODOY
DPO5ZE04 FRO0000S
DPOT 33040 CHARDS
g000z3100 300002
DPOT0E04 Fiz04

Map 16, 2001 174347

The Retrieved Instruments table displays details about the instruments. The time and date of instrument
refresh is displayed in the Last Updated field.

See also

m  Configure Tests (see page 51)

m  Equipment Connection Setup (see page 36)
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Test setup overview

Test setup includes acquisition and configuration parameters, but you can also select report options
when setting up tests. Use the options in the Setup panel (see page 19) and Reports panel (see page 29)
to select and configure tests.

Select device parameters (see page 43).

Select one or more tests (see page 44).

Select acquisitions (see page 46).

Configure tests (see page 51).

Set test measurement notification options (see page 56).

AN R e

Select report options (see page 56).

See also

m  Before You Click Start (see page 59)

B Pre-Run Checklist (see page 61)

B About Running Tests (see page 59)
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Select device parameters

Use the Setup panel DUT tab to select settings for the device under test. Options selected here affect
which tests are available in the Test Selection tab.

1.
2.

In the Setup panel, click the DUT tab.

If needed, in the DUT ID field, enter the ID for the device. The default value is DUT001. The name in
this field appears on reports.
(Optional) To add comments that will appear at the top of the test Report for the selected DUT, click

the note pad icon ( . ) to the right of the DUT ID field and specify a comment up to 256 characters.
(To enable or disable comments appearing on the test report, see Select Report Options (see page 56).)

Select whether to use a prerecorded waveform file or a live waveform for testing.

If you are rerunning a saved test and select to use a prerecorded waveform file, select the desired run
session. For more information, see Run a Saved Test in Prerecorded Mode (see page 62).

For View, select Compliance or Advanced.

NOTE. Ifyou select Advanced View, the configuration settings are included in the Setup steps as step 4. If
you select Compliance View, the configuration step is not included as a separate step. Access configuration
parameters for selected tests from the Configure button in the Test Selection tab.

6.

For Device Profile, select one:

- Host (default). Select this option to enable selecting Host tests listed in the Test Selection tab.
To include measurements related to an attached copper cable, select the 10GSFP+Cu Direct
Attach Cable check box.

= Module. Select this option to enable selecting Module tests listed in the Test Selection tab.

See also

About Setting Up Tests (see page 33)

Select a Test (see page 44)

Use Prerecorded Waveforms for Analysis (see page 48)

Acquire Live Waveforms for Analysis (see page 49)
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Select a test

44

Select a test

Tests listed in the Test Selection tab depend on whether you selected Host or Module in the DUT tab. Use
these instructions to select the tests to run on the connected DUT. Select tests individually or by group. To
see a short description of a test, select the test in the list.

w oo

Select the desired test(s):

In the Setup panel, click the Test Selection tab.

All required tests are selected by default. Click Deselect All if you do not want to run all required tests.

- To select all required tests, click the Select Required button.

= To select all tests in the list, click the Select All button.

- To select an entire test group, select the check box for the test group; tests listed under the group

are automatically selected.

= To select one or more, but not all, tests in a test group, select only the check boxes for the desired

tests.

Test Selection Controls

Table 7: Setup panel test controls

Description

When the View type selected in the DUT tab is Compliance,
this button opens the configuration section for the selected
test. If the View type is Advanced, this button is not displayed.

Displays the schematic document for the selected test. Use to
verify the test setup before running the test

Deselects all tests in the table

Selects tests required for compliance and deselects all other
tests currently selected

Selects all tests in the table

w - w
@ = £
pid g =
® g : 3
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B Select Acquisitions (see page 46)

B About Setting Up Tests (see page 33)
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About acquisitions

Use the Acquisitions tab in the Setup panel to view and set acquisition and save options (see page 46)

for the selected tests.

The information on the Acquisitions tab is specific to a test suite and gets updated when you change the

About acquisitions

selected test suite. This tab shows the acquisition details for the tests in the currently selected suite.

Other options available depend on whether you selected to acquire live waveforms (see page 49) or use
prerecorded waveform files (see page 48). For example, the top part of the Acquisitions tab is the data

source selection area. The information that appears here depends on whether you are using prerecorded
waveforms or live waveforms, and whether you selected Host profile or Module profile in the DUT tab.

Below the data source selection area is the test acquisition and mapping table. The Acquisitions table
shows the test name, acquisition, and signal type used for each test, and the waveform files used for

tests run in prerecorded mode.

Table 8: Acquisitions table

Column Name Function

Test Name Displays the name of the selected test to which the
acquisitions apply. One or more tests can perform the
same acquisitions.

Acquisition The acquisition of the waveform for the corresponding test

Signal Type Shows the acquisition parameters of the signal. This

column is displayed only if the Show Acquire Parameters
check box is selected in the Acquisition and Save Options
section.

Waveform File

Lists the name of the waveform files used for the test.

Select waveform files by clicking the button in the row

and selecting any waveform file using the standard File
Open window. This option is available only when Use

pre-recorded waveform files is selected in the Setup
panel DUT tab.

See also

B Seclect Acquisitions (see page 46)

m  About Setting Up Tests (see page 33)
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Select acquisitions

Use the Acquisitions tab in the Setup panel to view and set acquisition parameters for selected tests.
Options available depend on whether you are testing using live waveforms or prerecorded waveform files.

1. In the Setup panel, click the Acquisitions tab.
2. Do one of the following:

= For prerecorded waveform files: in the Acquisitions table, locate the row for the desired test

and then click the ellipsis button (&) in the Waveform FileName column. Select one or more
desired waveforms for each test.

- For capturing live waveforms, select the Data Source channels for positive and negative signals
if needed.

3. Deskew channels (see page 158).

4. Select the acquisition and save options (see page 46).

See also

B Configure Tests (see page 51)

B About Setting Up Tests (see page 33)

® Test Setup Overview (see page 42)

Acquisition parameters

Available acquisition options depend on the selected mode (Compliance or User Defined) and the type of
waveform being used, live or prerecorded.

Table 9: Acquisition and save options

Option Description
Show Acquire Parameters When selected, the signal acquisition parameter for each test displays in the Signal
Type column.

NOTE. The rest of the options in this table are available for live waveform acquisitions only.

Data Source (+) Sets the channels used for positive and negative data sources.
Data Source (-)

Signal Validation: Determines how the application responds to the source signal
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Table 9: Acquisition and save options (cont.)

Option Description

®  Prompt me if signal fails If the signal fails, pauses the measurement operation and displays a dialog box
with the following options:

Signal Validatien

Data Source (-)
Signal Type

= Reacquire: Try acquiring the signal again.
= Use Anyway: Use the signal even if it cannot be validated.

m  Skip Test: Abort the test if the signal cannot be validated.

To apply your selection to all future signal acquisitions in this test session only, select
Apply to all Subsequent Signals.

®m  Use signal as is—Don’t Check Skips the signal validation process. Does not test the signal for its characteristics

B Skip test if signal fails Moves to the next test (if applicable) if the signal fails

NOTE. The following Save options affect the order in which waveforms are acquired and analyzed.

Save All Waveforms Before Waveforms will be saved before being analyzed.

Analysis

Analyze Immediately—No Waveforms will be analyzed without being saved.

Waveform Saved

Save and Analyze Acquisition in Determines the order of acquisition and analysis during test execution
Sequence
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See also

B About Acquisitions (see page 45)

m  Seclect Acquisitions (see page 46)

Use prerecorded waveforms for analysis

Use prerecorded waveforms for analysis

48

Use prerecorded waveform files to run saved tests or to run a new test using a saved waveform from

another test.

Run a saved test in prerecorded mode (see page 62).

Run a new test using a prerecorded waveform file.

1. Create a new test (see page 31).

In the DUT tab of the Setup panel, select Use pre-recorded waveform files.

Change any other DUT parameters as desired (see page 43).

In the Test Selection tab, select the desired test(s) (see page 44).

RO SIS

In the Acquisitions tab, locate the Waveform FileName column in the Acquisitions table. Click the

ellipsis button () for each test and select one or more waveform files.

6. Change or select other parameters as needed and then click Start to run the test.

See also

B Test Setup Overview (see page 42)

B About Acquisitions (see page 45)

B Configure Tests (see page 51)
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Acquire live waveforms for analysis

Use these instructions to set up acquisition for a live waveform.

1. Open a saved test setup (see page 32) or create a new one (see page 31).

2. In the Setup panel DUT tab, enter the desired DUT in the corresponding field if needed and then
select Acquire live waveforms.

Select other DUT parameters (see page 43) as desired.

In the Test Selection tab, select the desired test(s) (see page 44).

In the Acquisitions tab, select the channels for the positive and negative data sources if needed.

Deskew channels (see page 158) if needed.

Select other desired acquisition and save options (see page 46).

® XS

Configure the tests (see page 51) if needed and then click Start to run the test.

See also

B About Acquisitions (see page 45)

m_ Select Acquisitions (see page 46)

B Use Prerecorded Waveforms for Analysis (see page 48)

About configuring tests

Use configuration settings to view and edit the analysis parameters for selected tests.

The Configuration tab shows Global parameters and Measurement parameters.

Global parameters are common for all tests and are applied to all tests in the session until you change the

settings or select a different test setup.
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{+) Compliance Mode | | User Defined Mode ﬁ -
o e |
Instruments Detected

Real Time Scope DPO72004C ( GPIES:: 1::INSTR )

Record Length
El [v]

|/ Use Filter File for De-embeding
Select Filter File

Use Filter File for De-embeding (only for TWDPC )
Select Filter File

NOTE. The Use Filter File for De-embedding (only for TWDPC) check box is available only if the test
Host Output TWDPC is selected in the Test Selection tab.

Measurement parameters are specific to the test selected in the tree view section of the configuration

settings. Test-specific parameters can include acquisition, analysis, and limit parameters, and certain
oscilloscope settings.

Whether you can configure settings depends on which mode you selected, Compliance or User Defined.
For more information, see About Setting Up Tests (see page 33).
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(+) Compliance Mode | | User Defined Mode

SO

Single Ended Output Voltage Range
- Qutput AC Common Mode voltage (RMS)
E—J--S_FF-3431 Table 12 Jitter and Eye Mask Specifications at B

i Data Dependent Jitter

Data Dependent Pulse Width Shrinkage
i Uncomelated Jitter
o Transmitter Glisg
‘... Fum Mask Hit Ratin

Prosst ||

NOTE. If you selected Compliance View in the DUT tab, you will access test configuration settings using
the Configure button in the Test Selection tab. If you selected Advanced View, access test configuration
settings from the Configuration tab in the Setup panel.

See also

m_ Configure Tests
B About Running Tests (see page 59)

Configure tests

Use these instructions for configuring tests.
1. Do one of the following:

= Ifyou selected Compliance View in the DUT tab, then in the Test Selection tab, select the desired
test in the list and click Configure.
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NOTE. To return to test selection from the Configuration section, click the Test Selection button.

= Ifyou selected Advanced View, click the Configuration tab in the Setup panel.
2. Select the desired mode:

= Compliance Mode: Select to use Compliance Mode values. You cannot change most test
parameters in Compliance mode but you can view the parameters.

= User Defined Mode: Select to run tests with custom parameters.

3. To select parameters that apply to all tests selected for the current session, click the Global Settings
tab and do any of the following:

= To change the oscilloscope used for testing, in the Instruments Detected section, click in the
shaded area opposite Real Time Scope and select the desired instrument from the drop-down list.
If the oscilloscope you want is not listed, refresh the list (see page 40).

= To select a filter file for de-embedding the signal, select the Use Filter File for De-embedding
check box. Click the Browse button that appears and select a filter file to use.

= To select a filter file for de-embedding the signal for Host Output TWDPc tests, select the Use
Filter File for De-embedding (only for TWDPC) check box. (Available only if the Host Output
TWDPc test is selected in the Test Selection tab.) Click Browse and select a filter file to use.

4. To change the signal for a specific test (in User Defined Mode), click the Measurements tab, select the
test in the tree view section and then select the signal type in the Acquire section.

5. To view test limits (in Compliance Mode) or change test limits (in User Defined Mode), click the
Limits Editor button to access the Limits Editor window.

See also

B Common Test Parameters and Values (see page 52)

m De-embed Using Filter Files (see page 157)

B Select Report Options (see page 56)

B About Setting Up Tests (see page 33)

Common test parameters and values

The following table lists the measurement parameters common to most tests.

NOTE. If you change the channel selection for Data+ (DP) and Data— (DN) signals, make sure that you
change the corresponding trigger source in the Analyze tab for each of the measurements. If you do not do
this, the waveform might not trigger and the measurements might not be completed.

52 TekExpress SFP-TX Compliance and Debug Solution



Setting up and configuring tests Common test parameters and values

Table 10: Common parameters and values

Parameter Type Parameter and Default Value
Mode Determines whether test parameters are in compliance or can be edited

m  Compliance: Most test parameter values cannot be changed.

B User Defined: Most test parameter values can be changed.

Global Settings These settings apply to all tests selected for the current session. You can
change only some of these settings.

= Real Time Scope: Specifies the oscilloscope used for tests

Record Length: Specifies the length of the record (5M is the default)

Use Filter File for De-embedding: When selected, provides a browse
button and field for selecting a filter to use to compensate for cable lengths.

Use Filter File for De-embedding (only for TWDPC): When selected,
provides a browse button and field for selecting a filter to use to
compensate for cable lengths.

Data Rate: Select the signal data rate as one of 9.95328 Gbps,
10.3125 Gbps (default), 10.51875 Gbps, or 11.10 Gbps.
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Table 10: Common parameters and values (cont.)

Parameter Type Parameter and Default Value
Measurements Acquire:

®m  Signal Type: Specifies the signal type of the acquisition for the test
selected in the tree view of the Measurements tab. Running tests in User
Defined Mode allows you to perform the tests on different types of signal.
The default signal type varies by test. Not all tests support all the signal
types. For each test, the application includes the signal type options that
are best suited to the measurements (see page 109).

®  Window Size (%): Host test Transmitter Qsq only. Set at 10% for
Compliance Mode. In User Defined Mode, you can change this to 5%
or 20%.

Limits Shows the upper and lower limits for the applicable measurement using
different types of comparisons. In Compliance Mode, allows you to view the
measurement high and low limits used for the test selected in the tree view of
the Measurements tab. When running tests in User Defined Mode, you can
edit the limit settings in the Limits Editor.

Limits Editor
Yiew or Edit the values

A blank cell means no limit

Test Hame Details Compare String Low Limit Compare String High Limit
Crosstalk Source ... Crosstalk Source A,,, ==Equal To 1000

Crosstalk Source Ri... == Equal To G4
Crosstalk Source ...
Crosstalk Source Fa... == Equal To 34

Data Dependent ... Dats Dependent Jit.., < Less Than .1

Data Dependent ... Dats Dependent Pu... < Less Than
Eve Mask Hit Ratio Eve Mask Hit Ratio < Less Than

) . Signal Rise Time (p5) = Greater Than = Greater Than Or Equal To
signal Rise/Fall T... . <= Less Than Or Equal To
Signal Fall Time (pS) = Greater Than

Total Jitter Tokal Jitker (UL} < Less Than

When running tests in User Defined Mode, the cells in the Limits Editor
table are active for editing so you can change parameters.

See also

B Configure Tests (see page 51)

m  Select Acquisitions (see page 46)

m De-embed Using Filter Files (see page 157)
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Configure email notification

To be notified by email when a test completes, fails, or produces an error, configure the email settings.

1.
2.

From the Options menu, select Email Settings to open the Email Settings (see page 56) dialog box.

(Required) For Recipient email Address(es), enter your email address. To include multiple addresses,
separate the addresses with commas.

(Required) For Sender’s Address, enter the email address used by the instrument. This address consists
of the instrument name followed by an underscore followed by the instrument serial number, then the
@ symbol and the email server used. For example: DPO72004C_B130099@yourcompany.com.

(Required) In the Server Configuration section, type the SMTP Server address of the Mail server
configured at the client location, and the SMTP Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name, password, and host name
in the corresponding fields.

NOTE. If any of the above required fields are left blank, the settings will not be saved and email
notifications will not be sent.

8.
9.

In the Email Attachments section, select from the following options:
= Reports: Select to receive the test report with the notification email.

= Status Log: Select to receive the test status log with the notification email. If you select this
option, then also select whether you want to receive the full log or just the last 20 lines.

NOTE. The ScoreCard and Analysis Screenshot options are not available in SFP-TX.

In the Email Configuration section, select as desired:
= Select the message file format to send: HTML (the default) or plain text.

= Enter a maximum file size for the email message. Messages with attachments larger than this
limit will not be sent. The default is 5 MB.

= To limit the number of attempts the system makes to send a notification, enter the number in the
Number of Attempts to Send field. The default is 1. You can also specify a timeout.

Select the Email Test Results When complete or on error check box. Use this check box to quickly
enable or disable email notifications.

To test your email settings, click Test Email.

To apply your settings, click Apply.

10. Click Close when finished.
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Email settings

Select test notification preferences

Select how you want to be notified by the system when a test measurement fails:
1. In the Setup panel, click the Preferences tab.
2. Select one or both of the following options:

= On Test Failure, pause the test and let me investigate: Select this option to have the test pause
on a failure so that you can investigate and change test parameters if necessary.

= On Test Failure, stop and notify me of the failure: Select this option to have the test stop and
notify you by email if the test fails. If you select this option, select the Email Test Results when
complete or on error check box in the Email Settings dialog box. Click Email Settings and
configure the email settings (see page 55) if you have not already done so.

See also

®  About Setting Up Tests (see page 33)

E  Select Report Options (see page 56)

Select report options

Use the Reports panel (see page 29) to select which test information to include in the report, and the naming
conventions to use for the report. For example, always give the report a unique name or select to have the
same name increment each time you run a particular test. Generally, you would select report options before
running a test or when creating and saving test setups. Report settings are included in saved test setups.

In the Reports panel, select from the following report options:
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Select report options

Table 11: Report options

Setting

Description

Report Name

Displays the name and location where the report will be saved when generated. This field is blank
by default. The report and related files are stored in the Untitled Session folder located at \My
TekExpress\SFP-Tx \Untitled Session by default. The report file in this folder gets
overwritten each time you run a test, and gets deleted when you close the application. To preserve
your test results, specify a unique name or select to auto increment the report name, then save
the test before running another test or exiting the application.

Change the report name or location.
Do one of the following:
®m  In the Report Name field, type over the current folder path and name.

®  Double-click in the Report Name field and then make selections from the
popup keyboard and click the Enter button.

Be sure to include the entire folder path, the file name, and the file extension.
For example: C:\Documents and Settings\your user name\My Documents\My
TekExpress\SFP-Tx\DUT001_group1.mht.

NOTE. You cannot set the file location using the Browse button.

Open an existing report.

Click Browse, select the report file and then click View at the bottom of the panel.

Save As Type

Saves a report in a file type different from the default. Lists supported file types to choose from.

NOTE. If you select a file type different from the default, be sure to change the report file name
extension in the Report Name field to match.

Auto increment
report name if
duplicate

If the application finds a report with the same name as the one being generated, the application
automatically increments the name of the report. For example: DUT001, DUT002, DUT003. This
option is enabled by default. This option is not available if Append Reports is selected.

Include Pass/Fail
Results Summary

The color block labeled Test Result indicating whether the test passed or failed will be included in
the report. For details, see Report Contents in View a Report (see page 65).

Include Detailed
Results

The report will include parameters measured, such as Margin, Low Limit, High Limit, Compliance
Mode Yes/No, Execution Time, and test-specific Comments generated by the software.

Include Plot Images

Screen shots captured from the oscilloscope during test execution that show the waveform and
measurement data will be included.

Include Setup
Configuration

Information about hardware and software used in the test will be included in the summary box
at the beginning of the report. Information includes: the oscilloscope model and serial number,
firmware version, SPC and factory calibration status, and software versions for applications used
in the measurements.

Include Complete

A table listing general, common, and acquired parameters used in the test will be included in

Application the report. This option is disabled by default.

Configuration

Include User Select to include any comments about the test that you or another user added in the DUT tab of
Comments the Setup panel. Comments appear in the Comments section under the summary box at the

beginning of each report.
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Table 11: Report options (cont.)

Setting Description

Append Reports This option adds new report data to the end of an existing report of the same name. This option is
disabled by default. This option is not available if the Auto Increment Report Name if Duplicate
option is selected.

View Report After Automatically opens the report in your Web browser when the test completes. This option is
Generating selected by default.
See also

B View a Report (see page 65)

B About Setting Up Tests (see page 33)
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About running tests

After selecting and configuring tests, review the pre-run checklist (see page 61) and then click Start to
perform the tests. The application acquires and analyzes the data, then displays a report when the tests
are finished.

While the tests are running, other applications may display windows in the background. The TekScope
application takes precedence over other applications, but you can switch to other applications by using
the Alt+Tab key combination. To keep the TekExpress SFP-TX application on top, select Keep On
Top from the SFP-TX Options menu.

See also
B Before You Click Start (see page 59)

m  About Configuring Tests (see page 49)

m  About Setting Up Tests (see page 33)

Before you click start

Before you run tests for the first time, do the following:
1. Understand where your test files are stored on the instrument.
After you install and launch TekExpress SFP-TX, it creates the following folders on the oscilloscope:
= \My Documents\My TekExpress\SFP-Tx
= \My Documents\My TekExpress\SFP-Tx\Untitled Session

Every time you launch TekExpress SFP-TX, an Untitled Session folder is created in the
SFP-Tx folder. The Untitled Session folder is automatically deleted when you exit the SFP-Tx
application. To preserve your test session files, save the test setup before exiting the TekExpress
application.

A CAUTION. Do not modify any of the session files or folders because this may result in loss of data

or corrupted session files. Each session has multiple files associated with it. When you save a
session, a .TekX file, and a folder named for the session that contains associated files, is created
on the oscilloscope X: drive.

2. Map the shared My TekExpress folder (see page 159) as X: (X drive) on the instruments used in test
setups running Microsoft Windows Operating System.

The My TekExpress folder has the share name format <domain><user ID>My TekExpress. Or, if
the instrument is not connected to a domain, the share name format is <instrument name><user
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Before you click start

ID>My TekExpress. This shared folder is used to save the waveform files and is used during other

file transfer operations.

NOTE. If'the X: drive is mapped to any other shared folder, the application will display a warning message

asking you to disconnect the X: drive manually.

3. Make sure that the My TekExpress folder has read and write access, and that the contents are not set

to be encrypted:

a. Right-click the folder and select Properties.

b. Select the General tab and then click Advanced.

¢. In the Advanced Attributes dialog box, make sure that the option Encrypt contents to secure

data is NOT selected. Example.

| My TekExpress Properties [

General | Sharing I Security I Presvious Yersions Customize|

-

Advanced Attributes

Choose the sethings you wank For this Folder,

as well,

Archive and Index attributes

"] Folder is ready for archiving

properties

Compress or Encrypt attributes

When you click OF or Apply on the Properties dislog, you will be
asked if wou want the changes to affect all subfolders and files

Allaw Files in this folder ko have contents indexed in addition to file

[

Compress contents to save disk space
crypt conkents to secure data Dietails
’ oK ] [ Cancel
[ ]
QK ] ’ Cancel ] Apply

4. See the pre-run checklist (see page 61) before you run a test.

See also

®  Configure Tests (see page 51)

m View Test-Related Files (see page 69)

B Application Directories and Usage (see page 9)
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®m File Name Extensions (see page 11)

Pre-Run checklist

Do the following before you click Start to run a test. If this is the first time you are running a test on a
setup, refer to the information in Before You Click Start (see page 59).

1.
2.

Make sure that all the required instruments are properly warmed up (approximately 20 minutes).
Perform Signal Path Compensation (SPC).

a. On the oscilloscope main menu, select the Utilities menu.

b. Select Instrument Calibration.

Deskew channels (see page 158).

Verify that the application is able to find the DUT. If it cannot, perform a search for connected
instruments (see page 40).

a. In SFP-TX, select the Setup panel and then click the Test Selection tab.
b. Select any test and then click Configure.
c. In the Configuration section, click Global Settings.

d. In the Instruments Detected section, click the drop-down arrow to the right of Real Time Scope
and make sure that the oscilloscope with the (GPIBS8::1::INSTR) designation is in the list.

See also

B Equipment Connection Setup (see page 36)
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Run a saved test in prerecorded mode

62

Use this option to rerun a complete test using just the oscilloscope and the saved test setup files, provided
that you selected to save the captured waveforms when you originally ran the saved test.

NOTE. When you run a saved test in prerecorded mode and then save it under the same name, the test
results are saved in a new session folder named for the date and time of the session. Any test settings that
you changed for the session will be saved as a new test session file and be paired with a folder of the same
name. Example. When you open a test setup that has multiple sessions and you select a session from the
Run session list in the DUT tab, the settings associated with that test session are restored.

J 20111017 143500
J 20111017 143842
J 20111017 144545
J 20111017 144933
v 20111017 _143500
v 20111017 143842
vl 20111017 144645
v 20111017 144933

Each test session folder has a matching test session file that stores the individual test settings for that session.

1. Open a saved test setup (see page 32).

2. In the Setup panel, select the DUT tab and then select Use pre-recorded waveform files.
A Run session drop-down list appears that displays the previous saved sessions for this test.

3. From the Run session list, select the session to run.

NOTE. If you select a session for which no waveform files were saved, you will receive an error message.
Either select another test session or select waveform files to use. For details, see Step 2 of Select
Acquisitions (see page 46).

4. Click Start.

5. To save the test results, session settings, and related files, save the test setup before selecting another
test setup or exiting TekExpress SFP-TX.

See also

B Use Prerecorded Waveforms for Analysis (see page 48)
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View the progress of analysis

The Status panel (see page 26) displays a record of the test as it is executed. By default, the application

switches to this panel after you click the Start button to run a test. Choose from the following two views by
selecting the named tab, even while a test is in progress.

Test Status

The Test Status tab presents a collapsible table with information about each test as it is running. To
collapse and expand the table, click the expand (&d/id) collapse button.

Table 12: Status tab table

Column Description
Test Name Name of the test
Acquisition Describes the type of data being acquired

Acquire Status

Progress of the acquisition:
B To be started
= Completed Acquisition

= Prerecorded waveform

Analysis Status

Progress state of the analysis:

To be started

B |n progress

Completed
E  Aborted

Log View

The Log View tab provides a list of actions that happen as the test executes. Use this tab to review or

troubleshoot tests.

Table 13: Log view options

Item

Description

Message History

This window timestamps and displays all run messages.

Show Detailed Log

Select this check box to record a detailed history of test execution.

Auto Scroll Select this check box to have the program automatically scroll down as information is added
to the log during the test.
Clear Log Click this button to clear all messages in the Message History window.
Save Use to save the log file as a text file for examination. Displays a standard Save File window and

saves the status messages in the file that you specify.
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See also

B View Test Results (see page 64)

View test results

When a test completes running, the application switches to the Results panel (see page 28), which shows a
summary of test results. The Overall Test Result is displayed at the top left of the Results table. If all of the
tests for the session pass, the overall test result will be Pass. If even one test out of multiple tests fails, the

overall test result will show Fail, even if all the other tests passed.

NOTE. Results of Crosstalk measurements are not included in the Overall Test Results because these
measurements are informative only, so if any of the Crosstalk tests fails, it will not cause the overall
test results to fail.

Each test result occupies a row in the Results table. By default, results are displayed in summary format
with the measurement details collapsed and with the Pass/Fail column visible. Change the view in the
following ways:

B To expand all tests listed, select View Results Details from the Preferences menu in the upper right
corner.

m  To expand and collapse tests, click the plus and minus buttons.

B To collapse all expanded tests, select Preferences > View Results Summary.

®  To hide or show the Pass/Fail column, select Preferences > Show Pass/Fail.

®  To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.

B To expand the width of a column, place the cursor over the vertical line that separates the column
from the column to the right. When the cursor changes to a double-ended arrow, hold down the mouse
button and drag the column to the desired width.

B To sort the test information by column, click the column head. When sorted in ascending order, a
small up arrow is displayed. When sorted in descending order, a small down arrow is displayed.

B To clear all test results displayed, click Clear.

See also

B View a Report (see page 65)

B View the Progress of Analysis (see page 63)
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View a report

View a report

After the analysis, a report is automatically generated. By default, the report is displayed in your Web
browser unless you cleared the View Report After Generating check box in the Reports panel before
running the test. If you cleared this check box, or to view a different test report, do the following:

1. In the Reports panel, click the Browse button and locate the desired report.

The path to the report displays in the Report Name field.

NOTE. If you did not save the test setup after running the report and you either closed the application or
you ran another report, the report file was not saved.

2. At the bottom of the Reports panel, click View.

For information on changing the file type, file name, and other report options, see Select Report Options

(see page 56).

Report contents

In the report, a table shows the test name, measurement details, test result (pass/fail), mode, and analysis
time.

Setup Configuration Information

Setup configuration information is listed in the summary box at the beginning of the report. This
information includes the oscilloscope model and serial number, and software versions. To exclude this
information from a report, clear the Include Setup Configuration check box in the Reports panel before
running the test.

TEk[l'OIl/I_X TekExpress SFP+ Transmitter
Enabling Innovation HOSt Test Repor‘t
DUT ID : DUTO01 Device Type : SFP+ Tx Host
Date/Time : 10/5/2011 17:18 Execution Time : 1 Min
MOI/CTSIUTD/ Spec Version : 41
Overall Compliance Mode : Yes
Overall Test Result : Pass
Scope Medel : DPO72004C Scope FAW Version . 6.2.0 Build 26
Scope Serial Number:B130233 SPC, Factory Calibration . PASS PASS
SFP+Tx: 1.0.0.31)
TekExpress Version__ Framewaork:
DPOJET Version_"3.5.0 Build 14" |

Comments |

General Comment - SFP + Transmitter Host DUT
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User Comments

These appear in the Comments section directly below the summary box at the beginning of the test
report. To exclude these comments from a report, clear the Include User Comments check box in the
Reports panel before running the test.

Pass/Fail Summary

The Pass/Fail Summary column indicates whether a test passed or failed. If the test passed, the column cell
is green. If the test failed, it is red. To exclude this information from a report, clear the Include Pass/Fail
Results Summary check box in the Reports panel before running the test.

M e asuirement

Tesi Hame Details Measured value 5 Tesi Result Margin
Crosstalk Source Amplitude (p-p Crosstalk Source 495 4207834 Fail
Crozstalk Sowrce 49 94849267
Rize Time
Crosstalk Source Rise/Fall Time (0%
80%) Crosstalk Source Fall 51548428 -17 5484
Time
Signal Risa Time 49 5687116 P
Signal Rise/Fall Time (20%-80%) Sional Eall Tims 1 SRoEEET
Transmittar Qg Transmitlar (i 15911757 1665
Transmitter Q=g [for Cu) Transmitter Qsg Cu 156 6447972
Woltage Modulation Amplitude (p-pl WA, 497 9369639 m

Detailed Results

Includes detailed measurement information, as shown outlined in red in the following example. The
Comments column is for test-specific information that isn’t covered elsewhere. To exclude this information
from a report, clear the Include Detailed Results check box in the Reports panel before running the test.

Low High | Compliance | Execution

-
Limit | Limit Mode Time | -omments

Test Result Margin ‘

Plot Images

Plot images are screen shots captured from the oscilloscope during test execution. They show waveform
and measurement data. To exclude these from a report, clear the Include Plot Images check box in the
Reports panel before running the test.
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File | Edit | Vertical | Horiz/Acqg | Trig | Display | Cursors | Measure | Mask | Math | MyS e| | Utilities | Help |

,'I | \u'[ \\ /' '||| f'l ! 1] T /‘ \l

|
| I, / R
.\N\-\V\ j L \V o _(I \( L) lu.- \.\\Ha

T 72.2mV 2.0ps |@e» Soov || 2.0usidiv 100Gs/s 10.0ps/pt
FITTh 72.2mV 1000ps -6.01us -6.0us Preview Sample L
0 acqgs RL:2.0M

Man June 30, 2011 02:30:58

Jitter and Eye Diagram Analysis Tools

Description

Population Max-cc Min-cc
b Ll
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Application Configuration

View a report

This table lists general, common, and acquired parameters used in the test. General parameters
are those selected to be included in all tests (where applicable). General parameters are set in the
DUT tab. Acquire parameters are those that were actually used for the acquired signal during the
test. By default, this information is not included in test reports. To include this information in a
report, select the Include Complete Application Configuration check box before running a test.

General Parameters

Common Parameters

Parameter Name Parameter Value
DP Connected to CH1
DN Connected to CH3
Direct Attached Cable Cu Enabled
Prompt me if Measurement fails Disabled
Signal Validation Prompt me if signal fails
Mumber of retries for instrument 10 errors 3
[Time between retries (seconds) 20
ppend Report FALSE
Wuto increment report name if duplicate TRUE
Include Pass/Fail Results Summary TRUE
Include Detailed Results TRUE
Include Plot Images TRUE
Include Setup Configuration TRUE
Include Complete Application Configuration TRUE
Include User Comments TRUE
Save As Type Web Archive (*.mht;* mhtml}
View Report After Generating TRUE
Report Path
DUTID Comment General Comment - SFP + Transmitter
WMcquisition Save Options Save and Analyze Acquisitions In
Record Length 2.00E+06
On Failure Pause FALSE
On Failure Stop and Notify FALSE
Filter File Path (fit file)
Ppply Filter No
ACQ e entatio

Parameter Name

Parameter Value

Real Time Scope GPIBE:-1::INSTR

0 ACq

o Ana 0
o A
(]
Acg Para

Acquire Type Parameter Name Parameter Value
[Transmitter Qsg Acqguisition Signal Type 8180

Parameter Name

Analyze Parameters

Parameter Valug

Window Width (%)

10

68
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See also

B View Test Results (see page 64)

m  View Test-Related Files (see page 69)

View test-related files

Files related to tests are stored in the SFP-TX folder under the My TekExpress shared folder. In the
SFP-Tx folder, each test setup has a test setup file and a test setup folder, both with the test setup name:

) Host_tests

Vi Ho ot_tests

The test setup file is preceded by the SFP-TX icon and usually has no visible file extension.

Inside the test setup folder is another folder named for the DUT ID used in the test sessions. The default
is DUTO001.

Inside the DUTO01 folder are the session folders and files. Each session also has a folder and file pair, both
named for the test session using the naming convention (date) (time). Each session file is stored outside
its matching session folder:

Each session folder contains image files of any plots generated from running the test session. If you
selected to save all waveforms or ran tests using prerecorded waveform files, these are included here.

The first time you run a new, unsaved session, the session files are stored in the Untitled Session
folder located at . .\My TekExpress\SFP-Tx. The session setup file is named Untitled. When you
name and save the session, the test setup file is given the name you specify and the test-related files are
placed in a folder with the same name. A copy of the test files stay in the Untitled Session folder until you
run a new test or until you close the SFP-TX application.

See also

B File Name Extensions (see page 11)

m  Before You Click Start (see page 59)
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About the programmatic interface

The Programmatic interface allows you to seamlessly integrate the TekExpress test automation application
with the high-level automation layer. This also allows you to control the state of the TekExpress
application running on a local or a remote computer.

For simplifying the descriptions, the following terminologies are used in this section:

®  TekExpress Client: A high-level automation application that communicates with TekExpress using
TekExpress Programmatic Interface.

m  TekExpress Server: The TekExpress application when being controlled by TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for TekExpress Client.
TekExpress provides a client library for TekExpress clients to use the programmatic interface. The
TekExpress client library is inherited from .Net MarshalByRef class to provide the proxy object for the
clients. The TekExpress client library maintains a reference to the TekExpress Server and this reference
allows the client to control the server state.

et C# Net VB HNet Web TestStand
Client Client Client Client
Fy ry
‘\‘ v v /
TekEzpressChent Library
X
¥
TekExpress
See also

B Requirements for Developing TekExpress Client (see page 71)

® Remote Proxy Object (see page 73)

B (Client Proxy Object (see page 73)

Requirements for developing TekExpress client

While developing TekExpress Client, use the TekExpressClient.dll. The client can be a VB .Net, C#
.Net, TestStand or Web application. The examples for interfaces in each of these applications are in the
Samples folder.
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References required

B  TekExpressClient.dl1 has an internal reference to I1dT1glib.d11 and IRemoteInter-
face.dll.

m IIdlglib.d11 has areference to TekDotNetLib.d11.

B TIRemoteInterface.dl11 provides the interfaces required to perform the remote automations. It is an
interface that forms the communication line between the server and the client.

m 11d1gTlib.dT1 provides the methods to generate and direct the secondary dialog messages at the
client-end.

NOTE. The end-user client application does not need any reference to the above mentioned DLL files.
1t is essential to have these DLLs (IRemotelnterface.dll, 11diglib.dll and TekDotNetLib.dll) in the same
folder as that of TekExpressClient.dll.

Required steps for a client

The client uses the following steps to use TekExpressClient.d11 to programmatically control the
server:

Develop a client Ul to access the interfaces exposed through the server. This client loads
TekExpressClient.d11 to access the interfaces. After TekExpressClient.d11 is loaded, the client
UI can call the specific functions to run the operations requested by the client. When the client is up and
running, it does the following to run a remote operation:

1. To connect to the server, the client provides the IP address of the PC where the server is running.

2. The client locks the server application to avoid conflict with any other Client that may try to control
the server simultaneously. “Lock” would also disable all user controls on the server so that server
state cannot be changed by manual operation.

If any other client tries to access a server that is locked, it will receive a notification that the server
is locked by another client.

3. When the client has connected to and locked the server, the client can access any of the programmatic
controls needed to run the remote automations.

4. After the client operations finish, the client unlocks the server.

See also

m  About SFP-TX Application Commands (see page 80)
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Remote proxy object

The server exposes a remote object to let the remote client access and perform the server-side operations
remotely. The proxy object is instantiated and exposed at the server-end through marshalling.

MarshalByEef

TekExpress TekExpressClient

FemoteProxObiject

The following is an example:

RemotingConfiguration.RegisterwellKknownServiceType (typeof (TekExpressRe-
moteInterface), “TekExpress Remote interface”, WellknownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side. The client gets the
reference to this object when the client gets connected to the server.

For example,
//Get a reference to the remote object

remoteObject = (IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),
URL.ToString());

Client proxy object

Client exposes a proxy object to receive certain information.

MarshalByRef

TekEzpressClient

TekExpress [ clhonPromyObject
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For example,
//Register the client proxy object

weTlTKnownServiceTypeEntry[] e = RemotingConfiguration.GetRegisteredwell-
KnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterwellknownServiceType(typeof(ClientInterface),
“Remote Client Interface”, wellknownObjectMode.Singleton);

//Expose the client proxy object through marshalling
RemotingServices.Marshal(clientInterface, "Remote Client Inteface");
The client proxy object is used for the following:
®  To get the secondary dialog messages from the server.
B To get the file transfer commands from the server while transferring the report.

Examples
clientObject.clientIntf.Displaybialog(caption, msg,iconType, btnType);
clientobject.clientIntf.TransferBytes(buffer, read, fileLength);
For more information, click the following topic links.

Secondary Dialog Message Handling

MarshalByEef
Client Proxyrohject ]
TekEzpress |« TekExpressClient
Display Dislog)
secondary Dialog

The secondary dialog messages from the Secondary Dialog library are redirected to the client-end when a
client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to be displayed is checked
and if a remote connection is detected, the messages are directed to the remote end.

File Transfer Events
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When the client requests the transfer of the report, the server reads the report and transfers the file by
calling the file transfer methods at the client-end.

Client programmatic interface example

An example of the client programmatic interface is described and shown as follows:

Process flowchart
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Connect to Remote Object

'

Get Client id

'

Lock Server

'

Register for Status Change Notification

'

Select the requested tests

!

Set the necessary Patameters for each selected test

Handler for Status Change Notification

No
¢ Status = "Wait"/ “Error”
Run the test
Get Status Info
Get Status

'

Status= ‘Ready’

Do Actions based on Status

Set Response

Return to Main Flow O
Get Results

'

Process the Results

'

Unlock Server

'

Disconnect from Remote Object

!
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1. Connect to a server or remote object using the programmatic interface provided.

2. Get the client ID that is created when connecting to the remote object. This client ID is one of the
required parameters to communicate with the server.

NOTE. The server identifies the client with this ID only and rejects any request if the ID is invalid.

3. Lock the server for further operations. This disables the application interface.

NOTE. You can get values from the server or set values from the server to the client only if the application
is locked.

4. Register for receiving notifications on status change events on the server. To register you need to
give a handler as a parameter.

NOTE. Whenever there is a change in the status of the server, all the clients registered with the server
receive a notification from the server.

Select the tests that you want to run through the programmatic interface.
Set the necessary parameters for each test.

Run the tests.

® N

Poll for the status of the application.

NOTE. Skip step 8 if you are registered for the status change notification and the status is Ready.

9. After completing the tests, get the results.
10. Create a report or display the results and verify or process the results.
11. Unlock the server after you complete all the tasks.

12. Disconnect from the remote object.

Handler of status change notification

1. Get the status. If the status is Wait or Error, get the information that contains the title, message
description, and the expected responses for the status.

2. Perform the actions based on the status information.

3. Set the response as expected.
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See also

®  About SFP-TX Application Commands (see page 80)

B Program Example (see page 78)

Program example

This program example shows how to communicate between a PC and TekExpress SFP-TX remotely.

A typical application does the following:

1. Start the application.

2. Connect through an IP address.
m_Client.Connect("localhost") 'True or False
clientID = m_Client.getClientID

3. Lock the server.
m_Client.LockServer(clientID)

4. Disable the Popups.
m_Client.SetVerbosemMode(clientID, false)

5. Set the Dut ID.
m_Client.SetbutId(clientID, "DUT_Name")

6. Select a measurement.

mClient.SelectTest(clientID, "SFP+ Tx", "Host", "Single Ended Output
Voltage Range", true)

7. Select a channel.

mClient.SetGeneralParameter(clientID, "SFP+ Tx", "Host", "Single Ended
Ooutput voltage Range", "DP Connected To") 'Measurement selected

8. Configure the selected measurement.

mClient.SetGeneralParameter(clientiD, "SFP+ Tx", "Host", "Single Ended
Output voltage Range", "DP Connected to”) 'Single Ended Output Voltage Range
measurement selected

mClient.SetGeneralParameter(clientiD, "SFP+ Tx", "Host", "Single Ended
Output voltage Range", "DN Connected to") 'Single Ended Output Voltage Range
measurement

mClient.SetGeneralParameter(clientiD, "SFP+ Tx", "Host", "Single Ended
Ooutput Voltage Range", "Record Length$2m") 'Single Ended Output Voltage Range
measurement
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10.

11.

12.

13.

14.

mClient.SetAcquireParameter(clientiD, "SFP+ Tx", "Host", "Single Ended

Program example

Output voltage Range", "Signal Type") 'Single Ended Output Voltage Range measurement

selected

Run with set configurations.
m_Client.Run(clientID)

Wait for the test to complete.

Do

Thread.Sleep(500)
m_Client.Application_Status(clientID)
Select Case status

Case "wait"

'Get the Current State Information

mClient.GetCurrentStateInfo(clientID, WaitingMsbBxCaption, waitingMsbBxMes-

sage, WaitingMsbBxButtontexts)

'Send the Response

mClient.SendResponse(clientID, waitingMsbBxCaption, WaitingMsbBxMessage,

waitingMsbBxResponse)

End Select

Loop Until status = "Ready"

After the Test is Complete.

'Save all results values from folder for current run
m_Client.TransferResult(clientID, logDirname)
'Save all waveforms from folder for current run
m_Client.Transferwaveforms(clientID, logDirname)
'Save all images from folder for current run
m_Client.TransferImages(clientID, logDirname)
Unlock the server.
m_Client.UnlockServer(clientID)

Disconnect from server.

m_Client.Disconnect()

Exit the application.
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NI TestStand client example

The following is an example for NI TestStand Client available in the path: C:\Program

About SFP-TX application commands

Files\Tektronix\TekExpress\TekExpress SFP-Tx\Examples\Programmatic

Interface\TestStand

j TestStand - Sequence Editor [Edit] - [C:\...\Examples\Programmatic Interface\TestStand\TekExpressClientTS.seq [Read Only]]

EFile Edit Wiew Execute Debug Configure Source Control Tools Window Help

W% NET v| B E %

Wi M ainS equence

i

== ® =l
Main | Setup | Cleanup | Parameters | Locals
Skep

mCDnnect

| Lacking the server

mLockServer

|& Demonstrating - Time Out Feature of the client
mGet TimePeriod

3 shew deFault birme auk

2 Nows setting user specified Hmeout

mSet TimePeriod

3 wait

E‘?J Motice the change in UI after lock timesout
P

[% Need to lack the server again since it timed out
LockServer

mSet TinmePeriod

|«‘L Demanstrating Save/Recall Session

i®cetouio

3 Show default DUT 10

¥ serouto

mSaveSession

2 Motice the saved session
Savesessionis

22 Matice the saved As

mRecallSession

#lmatice the recalled session

If; Demonstrating Run, Query results and Transfer results

#run stop demo

mRun

3 wait

mStop

i bemo ends

mDisconnect

<End Group=

|~1 Lock the sever so that other client object will have rea...

ime Period Elapsed - Server unlocked. Lock server to ...

Description
Action, Create TekExpressClient.Client; Call Te...

"Locking server"
Action, Call TekExpressClient. Client.LockServer

Action, Get TekExpressClient. Client, TimeOut
“Default timeout”

"Setting user specified timeout”

Action, Call TekExpressClient. Client. Set TimeCut
TimeInterval{Parameters, TimeOuk + 2)
"Timeout”

Action, Call TekExpressClient. Client.LockServer
Action, Call TekExpressClient.Client,SetTimeOuk

Action, Call TekExpressClient. Client, GetDutId
"DUT I0"

Action, Call TekExpressClient.Client, SetDutId
Action, Call TekExpressClient.Client. SaveSession
"Session save"

Action, Call TekExpressClient.Client.Savesessio, ..

"Session save"
Action, Call TekExpressClient.Client.RecallSession
"Session save”

"RunfStop"

Action, Call TekExpressClient.Client.Run
TimeInterval{30)

Action, Call TekExpressClient. Client.Stop
"Demo ends"

Action, Call TekExpressClient. Client.Disconnect
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Flow Properties

Requirerents

Carmment

Connect to the ser...

Lock Server ko bloc, ..

Gets the Time Out ..

Sets the Time-ouk ..
Wait For the time p...

Lock Server ko bloc, ..

Sets the Time-ouk ...

Checking if DUT-id ...

Change the DUT id
Saves the current ...

Saves the current ...

Recall the saved s...

Run TekExpress re...
waik For the run tan.,
Transfer the repor...

Disconnect the Ser...

Click a client action below to see the command name, description, parameters, return value, and an

example, associated with the action.

Connect through an IP address (see page 86)

Lock the server (see page 87)

Disable the popups (see page 88)
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Set or get the DUT ID (see page 89)

Set the configuration parameters for a suite or measurement (see page 90)

Query the configuration parameters for a suite or measurement (see page 92)

Select a measurement (see page 93)

Select a suite (see page 94)

Select a channel (see page 95)

Configure the selected measurement (see page 97)

Run with set configurations or stop the run operation (see page 98)

Handle Error Codes (see page 99)

Get or set the timeout value (see page 100)

Wait for the test to complete (see page 100)

After the test is complete (see page 103)

Save, recall, or check if a session is saved (see page 106)

Unlock the server (see page 107)

Disconnect from server (see page 107)

string id
Name Type Direction Description
id string IN Identifier of the client performing the

remote function.

Ready: Test configured and ready to start
Running: Test running

Paused: Test paused

Wait: A popup that needs your inputs

Error: An error is occurred

string dutName

Name Type Direction Description
dutName string IN The new DUT ID of the setup
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out bool saved

Name Type Direction Description

saved bool out Boolean representing whether the
current session is saved

This parameter is used as a check in SaveSession() and SaveSessionAs() functions.

string ipAddress

Name Type Direction Description

ipAddress string IN The ip address of the server to which the client
is trying to connect to. This is required to
establish the connection between the server
and the client.

out string clientlD

Name Type Direction Description
clientid string ouTt Identifier of the client that is connected to the
server

clientld = unique number + ipaddress of the
client. For example, 1065-192.157.98.70

NOTE. If the dutName parameter is null, the client is prompted to provide a valid DUT ID.

NOTE. The server must be active and running for the client to connect to the server. Any number of
clients can be connected to the server at a time.

NOTE. When the client is disconnected, it is unlocked from the server and then disconnected. The id
is reused.

string dutld
Name Type Direction Description
dutld string ouT The DUT ID of the setup

The dutld parameter is set after the server processes the request.
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string device

Name Type Direction Description

device string IN Specifies the name of the device
string suite

Name Type Direction Description

suite string IN Specifies the name of the suite
string test

Name Type Direction Description

test string IN Specifies the name of the test to

obtain the pass or fail status

string parameterString

Name Type Direction Description

parameterString string IN Selects or deselects a test

int rowNr

Name Type Direction Description

rowNr int IN Specifies the zero based row index of

the sub-measurement for obtaining
the result value

NOTE. When the client tries to lock a server that is locked by another client, the client gets a
notification that the server is already locked and it must wait until the server is unlocked. If the client
locks the server and is idle for a certain amount of time, then the server is unlocked automatically
from that client.

out string[ ] status

Name Type Direction Description
status string array ouT The list of status messages generated
during run
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string name
Name Type Direction Description
name string IN The name of the session being

recalled

The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

NOTE. When the run is performed, the status of the run is updated periodically using a timer.

string name
Name Type Direction Description
name string IN The name of the session being saved

The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

Once the session is saved under ‘name’ you cannot use this method to save the session in a different
name. Use SaveSessionAs instead.

string name
Name Type Direction Description
name string IN The name of the session being

recalled

The same session is saved under different names using this method. The name parameter cannot be
empty. If it is empty, the client is prompted to provide a valid name.

bool isSelected

Name Type Direction Description

isSelected bool IN Selects or deselects a test
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string time

Name Type Direction Description

time string IN The time in seconds
which refers to the timeout
period

The time parameter gives the timeout period, that is the time the client is allowed to be locked and
idle. After the timeout period, if the client is still idle, it gets unlocked.

The time parameter should be a positive integer. Else, the client is prompted to provide a valid
timeout period.

bool_verbose

Name Type Direction Description
_verbose bool IN Specifies whether the verbose mode
should be turned ON or OFF

NOTE. When the session is stopped, the client is prompted to stop the session and is stopped at
the consent.

string filePath

Name Type Direction Description

filePath string IN The location where the report must
be saved in the client

NOTE. If the client does not provide the location to save the report, the report is saved at
C:\ProgramFiles.

NOTE. When the client is disconnected, the client is unlocked automatically.

out string caption

Name Type Direction Description
caption string out The wait state or error state message sent to
you
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out string message

Name Type Direction Description
message string ouT The wait state/error state message to you

out string[] buttonTexts

Name Type Direction Description

buttonTexts string array ouTt An array of strings containing the
possible response types that you can
send

string response

Name Type Direction Description

response string IN A string containing the response
type that can be selected (it must be
one of the strings in the string array

buttonTexts)
out string clientlD
Name Type Direction Description
clientlD string out Identifier of the client that is connected to the

server

clientlD = unique number + ipaddress of the
client. For example, 1065-192.157.98.70

Connect through an IP address

Command name Parameters Description Return Value Example
Connect() string This method Return value is m_Client = new Client()
ipAddress (see connects the client either True or /Im_Client is a reference to the
page 82) to the server. False. Client class in the Client DLL.
out string Note (see page 82 returnval as boolean
clientlD (see The client provides returnval = m_Client.Con-
page 82) the IP address nect(ipaddress,m_clientID)
to connect to the
server.
The server

provides a unique
client identification
number when
connected to it.
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Lock the server

Command name Parameters Description Return Value Example
LockSession() string clientID This method locks String value m_Client = new Client()
(see page 86) the server. that gives the /Im_Client is a reference to the
Note (see page 83 status of the Client class in the Client DLL.
The client must operation after returnval as string
call this method itis performed' returnval =
before running The return value m_Client.LockServer(clientID)
any of the remote is "Session
automations. The Locked...” on
server can be success.
locked by only one
client.

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Disable the popups

Disable the popups

Command name Parameters Description Return Value Example
SetVerboseMode() string clientID This method sets String that gives m_Client = new Client()
(see page 86) the verbose mode the status of the //m_Client is a reference to the

bool _verbose

(see page 85)

to either true or
false.

When the value
is set to true, any
message boxes
appearing during
the application
will be routed to
the client machine
that is controlling
TekExpress.

When the value is
set to false, all the
message boxes
are shown on the
server machine.

operation after it
is performed

When Verbose
mode is set to
true, the return
value is “Verbose
mode turned on.
All dialog boxes
will be shown to
client”.

When Verbose
mode is set to
false, the return
value is “Verbose
mode turned off.
All dialog boxes
will be shown to
server’.

Client class in the Client DLL.
returnval as string
Verbose mode is turned on

return=m_Client.SetVerbose-
Mode(clientID, true)

Verbose mode is turned off

returnval=m_Client.SetVer-
boseMode(clientID, false)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Set or get the DUT ID

Set or get the DUT ID

Command name Parameters Description Return Value Example
SetDutld() string clientID This method String that gives m_Client = new Client()
(see page 86) changes the DUT the status of the IIm_Client is a reference to the
string dutName ID of the set up. operation after it Client class in the Client DLL.
(see page 81) The .(éhent m:fzt is performed returnval as string
pDrch)¥| II?) a val Re}urn value return=m_Client.SetDutld(clien-
' is "DUT Id tID,desiredDutld)
Changed” on Note (see page 82
success
GetDutld() string clientlD This method gets String that gives m_Client = new Client()

(see page 86)

string dutld (see

page 82)

the DUT ID of the
current set up.

the status of the
operation after it
is performed

/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

return=m_Client. GetDutid(clien-
tID, out Dutld)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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TekExpress programmatic interface

Parameters

Set the configuration parameters for a suite or measurement

Description

Return Value

Set the configuration parameters for a suite or measurement

Example

SetGeneralParame-
ter

string clientID (see
page 86)

string device (see
page 83)

string suite (see

page 83)

string test (see
page 83)

string
parameterString
(see page 83)

This method sets
the number of video
lanes for the selected
measurement.

NOTE. Use this
command to select
a lane, channel, or
source type.

String that gives
the status of the
operation after it is
performed

The return value is
(an empty String) on
success.

m_Client = new
Client() //m_Client
is a reference to the
Client class in the
Client DLL.

returnval as string
Select Channel (see

page 91)
Select Measurement

Method (see
page 91)

SetAnalyzeParame-
ter()

string clientID (see

page 86)

string device (see

page 83)

string suite (see
age 8

string test (see
age 83
strin

parameterString
(see page 83)

Eti

g

This method sets
the configuration
parameters in the
Analyze panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

The return value is
(an empty String) on
success.

m_Client = new
Client() //m_Client
is a reference to the
Client class in the
Client DLL .

returnval as string

SetAcquireParame-
ter()

string clientID (see
page 86)

string device (see
page 83)

string suite (see

page 83)

string test (see
page 83)

string
parameterString
(see page 83)

This method sets
the configuration
parameters in the
Acquire panel of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal = remo-
teObject.SetAc-
quireParameter(id,
device, suite, test,
parameterString)
if ((OP_STATUS)
returnVal 1=
OP_STA-
TUS.SUCCESS)
return Command-
Failed(returnVal)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Select channel example

returnval=mClient.SetGeneralParameter(clientID, "SFP-Tx", "Host", "Signal Rise/Fall Time
(20%-80%)", "Data + Signal connected to Real Time Scope at$Channel 1")

Select measurement method example

returnval=mClient.SetGeneralParameter(clientID, "SFP-Tx", "Host", "Signal Rise/Fall Time
(20%-80%)", "Measurement Method$ Automatic")

Configure analyze parameters example

Parameter Example

Record Length returnval = mClient.SetAcquireParameter(clientlD, “SFP-Tx", “Host”,
“Single Ended Output Voltage Range”, “Signal Type$PRBS31")
returnval = mClient.SetAcquireParameter(clientlD, "SFP-Tx", "Host",
"Single Ended Output Voltage Range", "Record Length$2M")
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Query the configuration parameters for a suite or measurement

Query the configuration parameters for a suite or measurement

Command name Parameters Description Return Value Example
GetGeneralParam- string clientID This method The return value m_Client = new Client()
eter() (see page 86) gets the general is the general /Im_Client is a reference to the
string device configuration configuration Client class in the Client DLL.
(see page 83) parameters for parameter for returnval as string
string suite (see a given suite or a given suite or Query Channel (see page 93)
measurement. measurement
page 83) that is set. Query Measurement Method
string test (see (see page 93)
page 83)
string parame-
terString (see
page 83)
GetAnalyzeParam- string clientID This method gets The return m_Client = new Client()
eter() (see page 86) the configuration value is the /Im_Client is a reference to the
string device parameters set in configuration Client class in the Client DLL .
(see page 83) the Analyze tab of ~ parameter set in returnval as string
. . the Configuration the Analyze tab of
string suite (see Panel dialog b the Confiaurati
206 83 anel dialog box e Configuration
page 83) for a given suite or Panel dialog box
string test (see  measurement. for a given suite
page 83) or measurement.

string parame-
terString (see
page 83)

GetAcquireParame-
ter()

string clientID
(see page 86)
string device
(see page 83)
string suite (see
page 83)

string test (see

page 83)

string parame-
terString (see
page 83)

This method gets
the configuration
parameters set in
the Acquire tab for
a given suite or
measurement.

The return
value is the
configuration
parameter set

in the Acquire tab
for a given suite
or measurement.

Query Acquire Parameters
example (see page 93)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Query channel example

returnval=mClient.GetGeneralParameter(clientID, "SFP-Tx", "Host", "<Test/Measurement Name>",
"DP connected to")

Query measurement method example

returnval=mClient.GetGeneralParameter(clientID, "SFP-Tx", "Host", "<Test/Measurement Name>",
"Measurement Method")

Parameter

Query acquire parameter examples

Example

Record Length

returnval = mClient.GetAcquireParameter(clientID, "SFP+ TX", "Host",
"Single Ended Output Voltage Range", "Record Length$500K")

Select a measurement

Command name Parameters Description Return Value Example
SelectTest() string clientID This method String that m_Client = new Client()
(see page 86) selects or displays the /Im_Client is a reference to the
string device deselects a given status of the Client class in the Client DLL
(see page 83) test. gperatgn aftzr returnval as string
string suite (see ~~ When this itis performe Select Measurement (Signal
page 83) parameter is The refurn Rise/Fall Time (20%-80%)):
string test (see set to true, you value is . (an returnval=m_Client.Se-
can select a empty String) on . " "
page 83) lectTest(clientID, "SFP-Tx",
measurement. success. W meed . .
bool isSelected . Host", "Signal Rise/Fall Time
(ﬁ@ge_&") When this (20%-80%)", true)

parameter is
set to false, you
can deselect a
measurement.

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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94

Select a suite

Command name Parameters Description Return Value Example

SelectSuitet() string clientID This method String that gives m_Client = new Client()
(see page 86) selects or the status of the /Im_Client is a reference to the
string device deselects a given operation after it Client class in the Client DLL.
(see page 83) suite. is performed returnval as string
string suite (see  When t{nsl t Thle “?t“:'f‘ Select Suite (Default):
page 83) ﬁarame eris se value is ™ (an returnval=m__Client.Se-

, 0 true, you can empty String) on . " "

boolisSelected -+ Suite SUCCOSS lectTest(clientID, "SFP-Tx",
(see page 84) ' ' "Host", true)

When this

parameter is set
to false, you can
deselect a suite.

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Select a channel

Select a channel

Command name Parameters Description Return Value Example

SetGeneralParame-  string client/D This method sets String that gives m_Client = new Client()

ter() (see page 86) the parameters the status of the I/m_Client is a reference to the
string device that are not operation after it Client class in the Client DLL.
(see page 83) specmc to any is performed returnval as string
string suite (see 9 0" test. Thle rgtum Select Channel (see page 96)
page 83) NOTE. Use this ;?nu? ISStrin(a)non Select Measurement Method
string test (see ~ command fo select Py Sting (see page 96)
page 83) a lane, channel, or ~ SUCCESS.

. source type.

string parame-
terString (see
page 83)

SetAnalyzeParame- string clientID This method sets The return m_Client = new Client()

ter() (see page 86) the configuration value is ™" (an //m_Client is a reference to the
string device parameters in the empty String) on Client class in the Client DLL.
(see page 83) ﬁ}nal():/zef_tab Otf success. returnval as string
page 83) for a given suite or
string test (see  measurement.
page 83)

string parame-
terString (see
page 83)

SetAcquireParame-
ter()

string clientID
(see page 86)

string device
(see page 83)

string suite (see

page 83)

string test (see
page 83)

string parame-
terString (see
page 83)

This method sets
the configuration
parameters in the
Acquire tab of
the Configuration
Panel dialog box
for a given suite or
measurement.

returnVal = re-
moteObject.Se-
tAcquireParam-
eter(id, device,
suite, test, pa-
rameterString)

if (OP_STATUS)

returnVal !=
OP_STA-
TUS.SUC-

CESS) return

Command-
Failed(re-
turnVal)
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NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".
The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Select channel example

returnval=mClient.SetGeneralParameter(clientID, "SFP+ TX", "Host", "Single Ended Output Voltage
Range", "DP Connected toSCH1")

Select measurement method example

returnval=mClientSetGeneralParameter(clientID, "SFP+ TX", "Host", "Single Ended Output Voltage
Range", "Measurement Method$ Automatic")
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Configure the selected measurement

Configure the selected measurement

Command name Parameters Description Return Value Example
SetAnalyzeParame-  string clientlD This method The return m_Client = new Client()
ter() (see page 86) sets the Analyze value is ™ (an //m_Client is a reference to
string device parameters empty String)on  the Client class in the Client DLL.
(see page 83) (Configuration Success. returnval as string
string suite (see parameters) for a
given test.
page 83)
string test (see
page 83)
string parame-
terString (see
page 83)
SetAcquireParame- string client/D This method returnVal = re- m_Client = new Client()
ter() (see page 86) sets the Acquire moteObject.Se- /Im_Client is a reference to
string device parameters in the tAcquireParam- the Client class in the Client DLL.
(see page 83) Acquire tab of the  eter(id, device, returnval as string
string suite (see Configure Dialog suite, test, pa- Configure Acquire Parameters
page 83) ?eos); for a given .r:m;tsrsst;xg) for Record Length (see page 98)
string test (see ITL(J(S) -
page 83) wrnVal 1=
string parame- roePurgTZ-.—
terString (see a
TUS.SUC-
page 83) CESS) re-
turn Com-
mand-
Failed(re-
turnVal)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Run with set configurations or stop the run operation

Configure parameter example

Parameter

Example

Record Length

returnval = mClient.SetAcquireParameter(clientlD, "SFP-Tx", "Host",
"Single Ended Output Voltage Range", "Signal Type$PRBS31")

returnval = mClient.SetAcquireParameter(clientlD, "SFP-Tx", "Host",
"Single Ended Output Voltage Range", "Record Length$2M")

Run with set configurations or stop the run operation

Command name Parameters Description Return Value Example
Run() string clientID Runs the selected String that gives m_Client = new Client()
(see page 86) tests. Note (see the status of the //m_Client is a reference to the

page 84) operation after it Client class in the Client DLL.
After the server is performed returnval as string
is set up and The return value  yetyrnval=m_Client.Run(clien-
configured, run is "Runstarted.."  {|p)
it remotely using On success.
this function.

Stop() string clientID Stops the currently String that gives m_Client = new Client()

(see page 86)

running tests Note

(see page 85)

the status of the
operation after it
is performed.

The return value
is "Stopped..." on
success.

/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

returnval=m_Client.Stop(clien-
tiD)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Handle error codes

The return value of the remote automations at the server-end is OP_STATUS, which changes to a string
value depending on its code and returned to the client. The values of OP_STATUS are as follows:

Value Code Description

FAIL -1 The operation failed.

SUCCESS 1 The operation succeeded.

NOTFOUND 2 Server not found

LOCKED 3 The server is locked by another client, so the operation cannot
be performed.

UNLOCK 4 The server is not locked. Lock the server before performing
the operation.

NULL 0 Nothing
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Get or set the timeout value

Command name Parameters Description Return Value Example
GetTimeOut() string clientID (see Returns the current String that gives m_Client = new
page 86) timeout period setby  the status of the Client() //m_Client
the client operation after it is is a reference to the
performed Client class in the
The default return Client DLL.
value is 1800000. returnval as string
return-
val=m_Client.Get-
TimeOut()
SetTimeOut() string clientID (see Sets a timeout String that gives m_Client = new

page 86)

string time (see
page 85)

period specified
by the client.
After this timeout
period expires, the
server is unlocked
automatically.

the status of the
operation after it is
performed

On success the
return value is
“TimeOQut Period
Changed”.

Client() //m_Client
is a reference to the
Client class in the
Client DLL.

returnval as string
return-
val=m_Client.Set-

TimeOut(clientID,
desiredTimeOut)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Wait for the test to complete

The commands in this group execute while tests are running. The GetCurrentStatelnfo() and
SendResponse() commands are executed when the application is running and in the wait state.
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Command name Parameters Description Return Value Example

ApplicationStatus() string clientID This method gets the String value that m_Client = new Client()
(see page 86) status of the server gives the status /Im_Client is a reference to the

application. of the server Client class in the Client DLL.
The states at a given application returnval as string

time are Ready, returnval=m_Client.Applica-
Running, Paused, tionStatus(clientID)

Wait, or Error. (see

page 81)

QueryStatus() string clientID An interface for String that gives ~ m_Client = new Client()
(see page 86) the user to transfer the status of the /Im_Client is a reference to the
out string]] Analyze panel status operation afterit  Client class in the Client DLL.
status (see messageshfrorF the is performed returnval as string
page 83) server to the client On success the  retymval=m_Client.QueryS-

return value is tatus(clientID, out statusMes-
“Transferred...”. sages)

if ((OP_STATUS)returnVal ==
OP_STATUS.SUCCESS)

return “Status updated...”
else

return CommandFailed(re-
turnVal)
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Wait for the test to complete

Command name Parameters Description Return Value Example
GetCurrentState- string client/D This method gets the This command m_Client = new Client()
Info() (see page 86) additional information does not return IIm_Client is a reference to the
NOTE. This out string of the states when the  any value. Client class in the Client DLL.
command s caption (see application is in Wait This function m_Client.GetCurrentState-
used when the page 85) or Error state. populates the Info(clientID, caption,mes-
application is out string Except client D, all Out parameters sage, buttonTexts)
running and is in message (see the others are Out that are passed
the wait or error page 86) parameters. when invpking
state. out string[] this function.

buttonTexts

(see page 86)
SendResponse() string client/D After receiving the This command m_Client = new Client()
NOTE. This (see page 86) additional information does not return IIm_Client is a reference to the
comma'nd is out string using the method any value. Client class in the Client DLL.
used when the caption (see GetCurrentState- m_Client.SendResponse(cli-
application is page 85) Info(), the client de- entID, caption,message,
running and is in out string cides which response response)

. to send, and then

the wait or error Mmessage (see sends the response to
state. page 86)

string response

(see page 86)

the application using
this function. The
response should be
one of the strings that
was received earlier
as a string array in the
GetCurrentStatelnfo
function. The _cap-
tion and _message
should match the in-
formation received
earlier in the GetCur-
rentStatelnfo function.

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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After the test is complete

Command name Parameters Description Return Value Example

GetPassFailSta- string clientID This method gets String that gives m_Client = new Client()

tus() (see page 86) the pass or fail the status of the /Im_Client is a reference to the
string device status of the operation after it Client class in the Client DLL.
(see page 83) measurement after is performed returnval as string
stiing suite (see (5 completion. Retums the pass  retyrmval=m_Client.GetPass-
page 83) NOTE. Execute orfailstatusinthe  FajlStatus(clientID, device,
string test (see  this command form of a string suite, "Signal Rise/Fall Time
page 83) after completing (20%-80%)") //Pass or Fail

the measurement.

GetResultsValue() string clientlD This method gets String that gives m_Client = new Client()
(see page 86) the result values of  the status of the /Im_Client is a reference to the
string device the measurement operation after it Client class in the Client DLL.
(see page 83) after the run. Is performed returnval as srting
string suite (see Retumstheresult  rgtymyal=m_Client.GetRe-
page 83) valug in the form sultsValue(clientID, "SFP-Tx",
string test (see of a string "Host", "Signal Rise/Fall Time
page 83) (20%-80%)", "Measured Value")
string parame-
terString (see
page 83)

GetResultsValue- string clientlD This method gets String that gives m_Client = new Client()

ForSubMeasure- (see page 86) the result values the status of the /Im_Client is a reference to the

ments() string device for individual sub- operation after it Client class in the Client DLL.
(see page 83) n}fasttrj]rements is performed returnval as string
string suite (see 2 0 o Relturr)s tne ;esult Signal Rise/Fall Time
page 83) \c/)?:itlrri]nt e form returnval=m_Client.GetRe-
string test (see g sultsValueForSubMeasure-
page 83) ments(clientID, "SFP-Tx",

string parame-
terString (see
page 83)

int rowNr (see
page 83)

"Host", "Signal Rise/Fall
Time (20%-80%)", "Measured
Value",0) //For DP wfm

returnval=m_Client.GetRe-
sultsValueForSubMeasure-
ments(clientID, "SFP-Tx",
"Host", "Signal Rise/Fall
Time (20%-80%)", "Measured
Value",1) //[For DN wfm
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After the test is complete

Command name Parameters Description Return Value Example
GetReportParame- string clientID This method The return m_Client = new Client()
ter() (see page 86) gets the general value is the /Im_Client is a reference to the
string device report details such oscilloscope Client class in the Client DLL.
(see page 83) as oscilloscope model, returnval as string
string suite (see model, TekExpress Oscilloscope Model
a6 83 TekExpress version, and p .
page 83) version, and SFP-TX version. returnval=m_Client.GetRe-
string test (see SFP-TX version. portParameter(clientID,"Scope
page 83) Model")
string parame- TekExpress Version
terString (see returnval=m_Client.GetReport-
page 105) Parameter(clientID,"TekExpress
Version")
SFP-TX Version
returnval=m_Client.GetReport-
Parameter(clientID,"Application
Version")
TransferReport() string clientID This method String that gives m_Client = new Client()

(see page 86)

string filePath
(see page 85)

transfers the report
generated after the
run.

The report
contains the
summary of the
run.

The client must
provide the
location where
the report is to
be saved at the
client-end.

the status of the
operation after it
is performed

Transfers all the
result values in
the form of a
string

/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

returnval=m_Client.TransferRe-
port(clientlD,"C:\Report”)
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After the test is complete

Command name Parameters Description Return Value Example
TransferWave- string clientID This method String that gives m_Client = new Client()
forms() (see page 86) transfers all the the status of the /Im_Client is a reference to the
string filePath waveforms from operation after it Client class in the Client DLL.
current run. Transfers all the returnval=m_Client. Transfer-
NOTE. Each waveforms inthe  \ayeforms(clientID,"C:\Wave-

time you click
Start, a folder is
created on the X:

form of a string

On success the
return value is

forms”)

drive. Transfer the “Transferred...”
waveforms before
clicking Start..
Transferimages() string clientID This method String that gives m_Client = new Client()

(see page 86)
od

string filePath
(see page 85)

transfers all the
images (screen
shots) from the
folder for the

current run (for
a given suite or
measurement).

NOTE. Each
time you click
Start, a folder is
created in the X:
drive. Transfer the
waveforms before
clicking Start.

the status of the
operation after it
is performed
Transfers all the
images in the
form of a string

/Im_Client is a reference to the
Client class in the Client DLL.

returnval as string

returnval=m_Client.Transferlm-
ages(clientlD, "C:\Waveforms”)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Name

String parameterString

Type

Direction

Description

parameterString

string

IN

Specifies the oscilloscope model,
TekExpress version, and SFP-Tx
version.
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Save, recall, or check if a session is saved

Save, recall, or check if a session is saved

Command name Parameters Description Return Value Example
CheckSession- string clientlD This method Return value is m_Client = new Client()
Saved() (see page 86) checks whether either True or /Im_Client is a reference to the

out bool saved

(see page 82)

the current session

is saved.

False

Client class in the Client DLL.
returnval as string

returnval=m_Client.Check-
SessionSaved(m_clientID, out
savedStatus)

RecallSession()

string clientID

Recalls a saved

String that gives

m_Client = new Client()

(see page 86) session. The the status of the IIm_Client is a reference to the
string name client provides operation after it Client class in the Client DLL.
(see page 84) the session name. is performed returnval as string
Thf return value returnval=m_Client.RecallSes-
is “Session sion(clientID, savedSession-
Recalled...”. Name)
SaveSession() string clientID Saves the current String that gives m_Client = new Client()
(see page 86) session. The the status of the I/m_Client is a reference to the
string name client provides operation after it Client class in the Client DLL.
(see page 84) the session name. is performed returnval as string
The return value  retymyal=m_Client.SaveSes-
is "Session Sav- sion(clientID, desiredSession-
ed...""Failed...". Name)
SaveSessionAs() string clientlD Saves the current String that gives m_Client = new Client()

(see page 86)

string name
(see page 84)

session under a
different name
every time this
method is called.

The client provides

the session name.

the status of the
operation after it
is performed

The return value
is "Session
Saved...".

/Im_Client is a reference to the
Client class in the Client DLL.
returnval as string

returnval=m_Client.SaveSes-
sionAs(clientID, desiredSes-
sionName)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".
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Unlock the server

Unlock the server

Command name Parameters Description Return Value Example
UnlockSession() string clientID This method String that gives m_Client = new Client()
(see page 86) unlocks the server the status of the /Im_Client is a reference to the

from the client.
The ID of the client
to be unlocked
must be provided.
Note (see page 85

operation after it
is performed
The return value
is "Session
Un-Locked...".

Client class in the Client DLL.
returnval as string

returnval=m_Client.Unlock-
Server(clientID)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client".

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

Disconnect from the server

Command name Parameters Description Return Value Example
Disconnect() string clientID This method Integer value m_Client = new Client()
(see page 86) disconnects the that gives the /Im_Client is a reference to the

client from the
Server.
Note (see page 82

status of the
operation after
it is performed

1 for Success
-1 for Failure

Client class in the Client DLL.
returnval as string

returnval=m_Client.Discon-
nect(m_clientID)

NOTE. The Fail condition for PI commands occurs in any of the following cases:

The server is LOCKED and the message displayed is "Server is locked by another client”.

The session is UNLOCKED and the message displayed is "Lock Session to execute the command".

The server is NOTFOUND and the message displayed is "Server not found...Disconnect!".

When none of these fail conditions occur, then the message displayed is "Failed...".

TekExpress SFP-TX Compliance and Debug Solution

107



TekExpress programmatic interface Disconnect from the server
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Signal types used by tests

Signal types used by tests

The following tables list the signal types used by each measurement for the two profiles.

Host profile

Table 14: Host profile measurement signal types

Measurement Compliance mode support User-Defined Mode support
Single Ended Output Voltage Range PRBS31 PRBS9
Output AC Common-Mode Voltage PRBS31 PRBS9
(RMS)

Cross Talk Source Rise/Fall Time 8180 —
(20%-80%)

Cross Talk Source Amplitude (p-p) 8180 —
Signal Rise/Fall Time (20%-80%) 8180 —

Total Jitter PRBS31 PRBS9
Data Dependent Jitter PRBS9 PRBS31
Data dependent Pulse Width PRBS9 PRBS31
Shrinkage (DDPWS)

Uncorrelated Jitter PRBS9 PRBS31
Transmitter Qsq 8180 —

Eye Mask Hit Ratio PRBS31 PRBS9
Voltage Modulation Amplitude (p-p) 8180 —
Transmitter Qsq (for Cu) 8180 —
Output AC Common Mode Voltage PRBS31 PRBS9
(RMS) (for Cu)

Host Output TWDPc PRBS9 —

Module profile

Table 15: Module profile measurement signal types

Measurement Compliance mode support User-defined mode support
AC Common Mode Voltage Tolerance PRBS31 PRBS9

Single Ended Input Voltage Tolerance PRBS31 PRBS9

Cross Talk Source Rise/Fall Time 8180 —

(20%-80%)

Cross Talk Source Amplitude (p-p) 8180 —

Output AC Common-Mode Voltage PRBS31 PRBS9

(RMS)
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Measurement Compliance mode support User-defined mode support
Total Jitter PRBS31 PRBS9

Data Dependent Jitter PRBS9 PRBS31

Data dependent Pulse Width PRBS9 PRBS31

Shrinkage (DDPWS)

Uncorrelated Jitter PRBS9 PRBS31

Eye Mask Hit Ratio PRBS31 PRBS9

See also

B Signal Validation Procedure (see page 112)

B Select Acquisitions (see page 46)

®m Signal Validation for 8180 (see page 114)

B Signal Validation for PRBS9 (see page 113)
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Oscilloscope setup

The following tables show the generalized oscilloscope setup parameters for all tests, except where noted.

Table 16: Horizontal setup

Mode Sample Rate Record Length Acquisition Mode
Manual 100 GS/s (C series 5M, 10M 100 GS/s (C series
oscilloscopes) oscilloscopes) and
50 GSIs (B series 50 GS/s (B series

Table 17: Vertical setup

Channel 1 Channel 2

Position Scale Offset Position Scale Offset

0 Vertical setup 0 0 Vertical setup 0
procedure procedure

See also

m  Signal Validation Procedure (see page 112)
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Signal validation procedure

12

Each measurement goes through signal validation, signal acquisition, and measurement steps. Before
running any measurement, check the signal for validity. To do this, set up the oscilloscope to acquire the
signal and then test the signal for its characteristics such as voltage level and/or frequency. Once the
characteristics of the signal are correct, the signal is valid and ready for use in compliance measurements.
The signal validation procedure is the same for both Host and Module Profile measurements.

SFP+ solution supports three types of signals: PRBS9, PRBS31, and 8180.

NOTE. PRBS31 pattern validation is not done. The signal is assumed to be PRBS31.

Acquire the signal according to the SFF-8431 specification. The oscilloscope setup differs for each
measurement. For all measurements, use the following guidelines to set up the oscilloscope. For the
oscilloscope setup for individual tests, see the individual test topics.

After the signal is acquired, the measurement is conducted using either the base oscilloscope, DPOJET,
or the TekExpress algorithm library.

Oscilloscope setup guidelines
For all measurements, use the following guidelines to set up the oscilloscope:
B The signal is any channel, reference, or math waveform.

m  Set the vertical scale for the waveform so that the waveform does not exceed the vertical range of
the oscilloscope.

m  Set the sample rate to capture enough waveform detail and avoid aliasing.

= Longer record lengths increase measurement accuracy but the oscilloscope takes longer to measure
each waveform.

See also

B QOscilloscope Setup (see page 111)

®_ Signal Validation for PRBS9 (see page 113)

®m Signal Validation for 8180 (see page 114)
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Signal validation for PRBS9

The following describes the oscilloscope setup and signal validation measurement for PRBS9 signals.

1. Connect the input signal to the appropriate channels. (The channels are those selected as data sources
in the Acquisitions tab of the Setup panel.)

The vertical setup routine runs automatically to find the best fitting vertical scale.
Horizontal setup uses these parameters:

-~ Mode: Manual

= Sample Rate: 100 GS/s — C series, 50 GS/s — B series

Record Length: 100 k

- Acquisition Mode: Sample
2. On the oscilloscope, set Mathl = (Ch1l — Ch3).
3. Call the Signal Validation algorithm to verify the signal type.

The signal validation results are returned from the algorithm. If signal validation fails, display a
signal validation message.

See also

B Signal Validation Procedure (see page 112)

m  QOscilloscope Setup (see page 111)
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Signal validation for 8180

The following describes the oscilloscope setup and signal validation measurement for 8180 signals.

1. Connect the input signal to the appropriate channels. (The channels are those selected as data sources
in the Acquisitions tab of the Setup panel.)

The vertical setup routine runs automatically to find the best fitting vertical scale.
Horizontal setup uses these parameters:
= Mode: Manual
= Sample Rate: 100 GS/s — C series, 50 GS/s — B series
= Record Length: 1000
= Acquisition Mode: Average (# = 128)
2. Perform trigger setup for 8180:
- Trigger Type = Edge
= Trigger Source = Ch3
= Level = Set to 50%
- Slope = Rising
3. Set the following measurements on the oscilloscope:
= Meas 1 = Vpk-pk (Chl)
= Meas 2 = Vpk-pk (Ch3)

Meas 3 = Pos Width (Ch1) ( this measurement is located under the Time tab)
= Meas 4 = Neg Width (Chl)
= Meas 5 = Pos Width (Ch3)
= Meas 6 = Neg Width (Ch3)

4. Wait for 128 acquisitions.

Meas 1 and Meas 2 should have a mean value of > 100 mV. Meas 3, Meas 4, Meas 5, and Meas
6 should have mean values between 620 ps and 930 ps for the signal to be valid. If these values
are out of range, the signal is invalid.

See also

B Signal Validation Procedure (see page 112)

B Oscilloscope Setup (see page 111)
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Single-ended output voltage range

Single-ended output voltage range is measured as the single-ended peak-to-peak output voltage for the
positive and negative data channels on a single acquisition. This test is one of the SFF-8431 Table 11
Output Electrical Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Single-ended output voltage range is measured using base DPOJET.

m  Use DPOJET measurement name: Ampl > Max and Ampl > Min for Dp and Dn

Limits
For each of Dp and Dn: Minimum = —0.3 V; Maximum =4 V

Snapshot and cursor placement details
There will be two snapshots:

® A snapshot of Dp with cursors placed at maximum and minimum voltages of single-ended Pk-Pk
measurement value of Dp. Cursor values can be derived using DPOJET: Ampl > Cycle Max and
Ampl > Cycle Min for +ve and —ve peak, respectively for Dp.

B A snapshot of Dn with cursors placed at maximum and minimum voltages of single-ended Pk-PK
measurement value of Dn. Cursor values can be derived using DPOJET: Ampl > Cycle Max and
Ampl > Cycle Min for +ve and —ve peak, respectively for Dn.

See also

m  Oscilloscope Setup (see page 111)
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B Common Test Parameters and Values (see page 52)

Output AC Common-Mode voltage (RMS) (Host)

116

Output AC common-mode voltage is measured as the AC RMS voltage of the common mode ((DP+DN) +
2) signal. This test is one of the SFF-8431 Table 11 Output Electrical Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Output AC common-mode voltage is measured using the base oscilloscope.
1. Mathl = (Dp + Dn) + 2. Switch off channels connected to Dp and Dn.

2. Draw a histogram bounding box from the top left of the oscilloscope to the bottom right, and choose
Histogram Vertical.

3. Select Mathl1 as the histogram source.
4. From the Measure menu, select Histogram Measurements > Standard Deviation.

5. Do a single step run and measure the mean value of the histogram standard deviation. This is the
measurement result.

Limits

Maximum = 15 mV

Snapshot and cursor placement details

A snapshot where the histogram on math and the standard deviation value of the histogram is visible on
the screen. The standard deviation value visible on the screen should be the value reported in the report.
No cursors are required.

See also

m  Oscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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Crosstalk source Rise/Fall time (20% - 80%) (Host)

Crosstalk source rise/fall time is measured as the 20% — 80% (of VMA) Rise time and 80% — 20% (of
VMA) Fall time of the differential Crosstalk Source introduced to the signal. This test is one of the
SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): Table
12 Crosstalk Source Tests.

Signal validation

For compliance, perform signal validation for 8180 (see page 114).

Measurement procedure

The crosstalk source rise/fall time measurement is performed using the algorithm library.

Inputs to algorithm
®  Differential waveform obtained on a Math channel using Dp and Dn after deskewing

®m  Signal Type ("SFPPlus.SignalType")

Algorithm
B Input the differential waveform.

B Obtain values of vHigh and vLow as done in the VMA measurement (averaged over all the patterns
found in the waveform).

®  Find the position of the rising and falling edges in the input waveform.

B On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found (=
End) and traverse backward until the first point crossing the lower limit (20%) is found (= Start).

B On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found (=
Start) and traverse forward until the first point crossing the lower limit (20%) is found (= End).

B Transition time is computed as TT = (End — Start). This value is averaged across all edges.

B End

Outputs from algorithm

Rise time.
®  m_SFPPlusISDB.Result] Mean.Value = Tr.Mean
B m_SFPPlusISDB.CursorPos1Ver.Value = Risetime begin
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®  m_SFPPlusISDB.CursorPos2 Ver.Value = Risetime end
®  m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom

B m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set

Fall time.

m_SFPPlusISDB.Result2Mean. Value = Tf.Mean

m_SFPPlusISDB.CursorPos1 Ver. Value = Falltime begin

m_SFPPlusISDB.CursorPos2 Ver. Value = Falltime end

m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom

m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set

Limits

Target value = 34 ps

Snapshot and cursor placement details

This measurement has two snapshots: the first with cursors placed at the rise time, the second with cursors
placed at the fall time.

B Rise time: Zoom to the cursor positions. Cursorl = starting point of RT of first rising edge, cursor2 =
ending point of RT of first rising edge.

m  Fall time: Zoom to the cursor positions. Cursorl = starting point of FT of first falling edge, cursor2 =
ending point of FT of first falling edge.

See also

m  QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

Crosstalk source amplitude (p-p differential) (Host)

Crosstalk source amplitude is measured as the difference between the nominal one and zero levels,
which are defined as voltages measured in the mid 20% of the high (eight 1s) and low (eight Os) regions
respectively, of the differential crosstalk source introduced to the signal. This test is one of the SFF-8431
Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): Table
12 Crosstalk Source Tests.
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Signal validation

For compliance, perform signal validation for 8180 (see page 114).

Measurement procedure

The crosstalk source amplitude (p-p differential) measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Dp and Dn after deskewing

Algorithm

B Input the differential waveform.

B On the input waveform, identify the regions with the pattern 11111111 or 00000000.
B On each such pattern, measure the mean voltage in the middle 20% of the pattern.

B The mean voltages corresponding to the Signal High regions is taken as vHigh, and the mean voltages
corresponding to the Signal Low is taken as vLow. The vHigh and vLow values are averaged across
all regions.

B The required result Amplitude is given by, Amplitude = vHigh — vLow.
®  End

Outputs from algorithm

®  m_SFPPlusISDB.Resultl Max.Value = Amplitude.Maximum
®  m_SFPPlusISDB.CursorPos1Ver.Value = vHigh

®  m_SFPPlusISDB.CursorPos2 Ver.Value = vLow

Limits
Target value = 1000 mV

Snapshot and cursor placement details

This measurement has one snapshot with cursorl = +ve high of VMA, cursor2 = —ve high of VMA.

See also

®  Oscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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Signal Rise/Fall time (20% - 80%)

Signal rise/fall time is measured as the 20% — 80% (of VMA) Rise time and 80% — 20% (of VMA) Fall time
of the input signal. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

For compliance, perform signal validation for 8180 (see page 114).

Measurement procedure

The signal rise/fall time (20% — 80%) measurement is performed using the algorithm library.

Inputs to algorithm
®  Differential waveform obtained on a Math channel using Dp and Dn after deskewing

®m  Signal Type ("SFPPlus.SignalType")

Algorithm

E  Obtain values of vHigh and vLow as done in the “VMA” measurement. (Averaged over all the
patterns found in the waveform.)

B Find the position of rising and falling edges in the input waveform.

B On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found
(=End) and traverse backward until the first point crossing the lower limit (20%) is found (= Start).

B On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found
(=Start) and traverse forward until the first point crossing the lower limit (20%) is found (=End).

m  Compute Transition Time, TT = (End — Start) This value is averaged across all edges.

® End

Outputs from algorithm

Rise time.

®  m_ SFPPIlusISDB.Result] Mean.Value = Tr.Mean

®  m_SFPPIusISDB.CursorPos1 Ver.Value = Risetime begin
®  m_SFPPIlusISDB.CursorPos2 Ver. Value = Risetime end
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®  m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom

®  m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set

Fall time.

B m_SFPPlusISDB.Result] Mean. Value = Tf.Mean

®  m_SFPPlusISDB.CursorPos1 Ver.Value = Falltime begin

®  m_SFPPlusISDB.CursorPos2 Ver.Value = Falltime end

B m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom

B m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set

Limits

Minimum value = 34 ps

Snapshot and cursor placement details

This measurement has two snapshots: first with cursors placed at the rise time, second with cursors
placed at the fall time.

E  Rise time: Zoom to the cursor positions. Cursorl = starting point of RT of first rising edge, cursor2 =
ending point of RT of first rising edge.

m  Fall time: Fall time: Zoom to the cursor positions. Cursorl = starting point of FT of first falling edge,
cursor2 = ending point of FT of first falling edge.

See also

B Oscilloscope Setup (see page 111)

®  Common Test Parameters and Values (see page 52)

Total jitter (Host)

TJ, as used here, is the Level 1 definition for Total Jitter as described in the FC-MJSQ, where TJ is the
crossing width, defined as the late time at which the BER is 10-12 minus the early time at which the BER is
10-12, This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.
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122

Signal validation

Total jitter (Host)

Signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The software

assumes that the PRBS31 pattern is valid.

Measurement procedure

Total jitter is measured using base DPOJET.

B Deskew the Data+ and Data- inputs. Compute the differential signal on Math1l = Dp — Dn.

m  Use DPOJET TJ@BER measurement on the Math signal and Skew measurement on the single-ended

input signals.

DPOJET settings

m  Select Tab: Select Jitter > TJ@BER.

= Configure the source:

= Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp — Dn)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
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®  Configure Tab:
= Edges: Signal Type = Data
= Clock Recovery:
= Method = PLL Custom BW
= PLL Model = Type 11
= Damping = 700 m
- Loop BW =4 MHz
= Click the Advanced Button:
- Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
- Click OK.
= RjD;j:
For PRBS9 signal:
= Pattern Type = Repeating
= Pattern Length = 511 Ul
- BER 1E-=12
For PRBS31 signal:
= Pattern Type = Arbitrary
=  Window length = 10 UI
= Population = 100
= BER 1E-=12
= Filters: No filters
= General: OFF
= Global:
= QGating: OFF
= Quality: OFF
= Population: OFF
®  Results Tab: In the Options menu, deselect Display Units — Absolute.
B Click Single.
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Limits

Maximum value = 0.28 Ul

Snapshot and cursor placement details

No cursors are required because total jitter cannot be shown using cursors or snapshots. Instead, zoom
a part of the waveform to see the type of waveform used for the measurement. Zoom the waveform
between time 0 and (Horizontal scale + 104). If the record length is 2M, the number of points in the
zoomed part will be 200.

See also

B QOscilloscope Setup (see page 111)

m Common Test Parameters and Values (see page 52)

Data dependent jitter (Host)

DDJ is the range (max — min) of the timing variations measured on the Differential Signal with a crossing
level equal to the average value of the entire waveform being measured. The waveform is averaged
sufficiently to remove the effects of random jitter and noise in the system. This test is one of the SFF-8431
Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

For compliance, perform signal validation for PRBS9 (see page 113).

Measurement procedure
Data dependent jitter is measured using base DPOJET.
B Deskew the Data+ and Data- inputs. Compute the differential signal on Math1 = Dp — Dn

®  Use DPOJET DDJ measurement on the Math signal and Skew measurement on the single ended
input signals.
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DPOJET settings
®  Select Tab: select Jitter, click DDJ.
= Source configuration:

= Source = Math 1 (Dp — Dn)

Data dependent jitter (Host)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
B Configure Tab:
= Clock Recovery:
- Method = PLL-Custom BW
= PLL Model = Type 11
= Damping = 700 m
= Loop BW =4 Mhz
= Click the Advanced button:
- Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
= Click OK.
- RjD;j:
For PRBS9:
= Pattern Type = Repeating
= Pattern Length = 511 Ul
= BER 1E-=12

TekExpress SFP-TX Compliance and Debug Solution

125



SFP-TX tests Data dependent pulse width shrinkage (Host)

For PRBS31:
= Pattern Type = Arbitrary
=  Window Length = 10 UI
= Population = 100
= BER 1E-=12
= Filters: No filters
= General: OFF
= Global:
= Gating: OFF
= Quality: OFF
= Population: OFF
B Results Tab: In the Options menu, deselect Display Units — Absolute.
m  (Click Single.

Limits

Maximum value = 0.10 UI

Snapshot and cursor placement details

No cursors are required because data dependent jitter cannot be shown using cursors or snapshots.
Instead, zoom a part of the waveform to see the type of waveform used for the measurement. Zoom the
waveform between time 0 and (horizontal scale + 104). If the record length is 2M, the number of points in
the zoomed part will be 200.

See also

m_ Oscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

Data dependent pulse width shrinkage (Host)

DDPWS is measured as the difference between one symbol period and the minimum of all the differences
between pairs of adjacent edges on the differential signal with a crossing level equal to the average value
of the entire waveform being measured. The waveform is averaged sufficiently to remove the effects of
random jitter and noise in the system. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask
Specifications at B tests.
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Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

For compliance, perform signal validation for PRBS9 (see page 113).

Measurement procedure

The data dependent pulse width shrinkage measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Data+ and Data— after deskewing.

Algorithm
®  [nput differential waveform.
B Estimate the Ul of the waveform (UI = bit duration). Identify the Edges on the input waveform.

®  Consider a cycle of PRBS 9 pattern. (A cycle contains 511 bits or 256 edges). Identify the lowest Ul
in the cycle (for example, the lowest time duration between adjacent edges in a cycle). Average this
minimum value across multiple cycles of PRBS9 present in the input waveform. (In the case of a non
PRBS 9 waveform being used, consider all the edges and Uls in the waveform as a single cycle.)

®  Compute Data Dependent Pulse Width Shrinkage (DDPWS) as: DDPWS = Estimated Ul — minimum
UL

® FEnd

Outputs from algorithm
®  m_SFPPlusISDB.Result] Mean.Value = DDPWS.Mean

B m_ SFPPlusISDB.CursorPos1 Ver.Value = beginning of smallest Ul

®  m_SFPPlusISDB.CursorPos2 Ver.Value = end of smallest UL

®  m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom
B m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set

Limits

Minimum value = 0.055 Ul
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Snapshot and cursor placement details

This measurement has one zoomed snapshot with cursorl and cursor2 marking the smallest UI.

See also

m  QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

Uncorrelated jitter (Host)

128

Uncorrelated jitter refers to the component of jitter in the transmitted signal that is not correlated to the
transmitter data. The uncorrelated jitter (rms) is given by the RMS value of the standard deviations of the
two distributions, namely standard deviation of jitter on rising edge and standard deviation of jitter on
falling edge. This test is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

For compliance, perform signal validation for PRBS9 (see page 113).

Measurement procedure

The uncorrelated jitter measurement is performed using the algorithm library.

Inputs to algorithm
m  Differential waveform obtained on a Math channel using Data+ and Data— after deskewing

= Signal Type ("SFPPlus.SignalType")

Algorithm
® Input differential waveform.

B [dentify the deviation of each rising and falling edge on the input signal from its ideal location
(constructed using Ul = 1+ data rate) (Note: consider the rising and falling edges of a pattern with the
longest run of 1s to maintain some uniformity on the edges to measure deviations. If the deviations
were measured on all edges, then the deviations are inconsistent for different edges resulting in
measurement errors.)

®  Find the standard deviation of the deviations of the rising edges. Find the standard deviation of the
deviation of the falling edges.
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®  Compute UJ as follows:

[2 2
=(o,+ o5 )12

where o, is the standard deviation of the jitter on the rising edge

Uncorrelated jitter (rms):

where o is the standard deviation of the jitter on the falling edge

® End

Output from algorithm
m_SFPPlusISDB.Result]Mean.Value = UJ.Mean

Limits
Minimum value = 0.023 Ul

Snapshot and cursor placement details

No cursors are required. Uncorrelated jitter cannot be shown using cursors or snapshots. Zoom a part of the
waveform to see the type of waveform used for the measurement. Zoom the waveform between time 0 and
(horizontal scale + 104). If the record length is 2M, the number of points in the zoomed part will be 200.

See also

m_ Oscilloscope Setup (see page 111)

m  Common Test Parameters and Values (see page 52)

Transmitter Qsq

Transmitter Qsq is measured on the differential data signal as the inverse of Relative Noise (RN). This test
is one of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other tests.

Signal validation

For compliance, perform signal validation for 8180 (see page 114).

Measurement procedure

The transmitter Qsq measurement is performed using the algorithm library.
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Inputs to algorithm

®  Differential waveform obtained on a Math channel using Data+ and Data— after deskewing
®m  Signal Type ("SFPPlus.SignalType");

B Window Width (“SFPPlus.QsqWidth”);

Algorithm
B [Input differential PRBS waveform

m  Compute VMA as given by the VMA algorithm. On the input waveform, identify the regions with the
pattern 11111111 or 00000000.

B On each such pattern, measure the AC RMS voltage in the 10% window where the waveform is
the flattest.

B The AC RMS in the 11111111 regions is LevelONENoise, and that in 00000000 regions is

L2 .2
. . . levelONE + LevelZERO /2
LevelZERONoise. Noise (rms) is measured as: \/( ove rowe TLeve noise”)

2 )
RN = * Noise(rms)

B Measure Relative Noise as: VMA

The required result Tx Qsq is given by Tx Qsq =1 + RN
= End

Output from algorithm

m_SFPPlusISDB.Result] Mean. Value = TxQsq.Mean

m_SFPPlusISDB. Hist1Left.Value = Level ONEnoise window begin

m_SFPPlusISDB. Hist1Right.Value = LevelONEnoise window end
m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom for Level ONEnoise
m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set for LevelONEnoise
m_SFPPlusISDB. Hist2Left.Value = LevelZEROnoise window begin

m_SFPPlusISDB. Hist2Right.Value = LevelZEROnoise window end
m_SFPPlusISDB.HorizontalPos2.Value = position of the waveform where to zoom for LevelZEROnoise

m_SFPPlusISDB.HorizontalScale2.Value = scale of Zoom that is to be set for LevelZEROnoise

Limits

Minimum value = 50
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Snapshot and cursor placement details

This measurement has two snapshots with zoom showing one full period of the 8180 pattern. The first
snapshot has cursorl and cursor2 marking the flattest region of the high part of the period. The second
snapshot has cursorl and cursor2 marking the flattest region of the low part of the period.

See also

m  QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

Eye mask hit ratio (Host)

The required transmitter pulse shape characteristics are specified in the form of a mask of the transmitter

eye diagram (used to measure the number of Mask Hits). Eye mask hit ratio is computed using eye mask
hit ratio = (Number of Mask Hits x Signaling Speed) + (Number of Uls x Sampling rate). This test is one
of the SFF-8431 Table 12 Jitter and Eye Mask Specifications at B tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Eye mask hit ratio is measured using base DPOJET.
B Deskew the Data+ and Data— inputs. Compute the differential signal on Math1 = Dp — Dn.

®  Use DPOJET Mask Hits measurement on the Math signal and Skew measurement on the single-ended
input signals.

DPOJET settings
®  Select Tab: Select Eye >Mask Hits.
= Configure the Source:
= Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp—Dn)

= Select the Advanced check box and then set Reference Level % relative to Base Top as
follows:
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Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
®  Configure Tab:
- Edges: Signal Type = Data
= Clock Recovery:
= Method = PLL — Custom BW
= PLL Model = Type 11
= Damping =700 m
= Loop BW =4 MHz
= Click the Advanced button:
= Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
= Click OK.
= Click Apply.
- RjDI:
For PRBS9 signal:
= Pattern Type = Repeating
= Pattern Length = 511 UI
= BER 1E-=12
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For PRBS31 signal:
= Pattern Type = Arbitrary
=  Window length = 10 UI
= Population = 100
- BER 1E-=12
= Filters: No filters
= General: OFF
= Global:
= QGating = OFF
= Quality = OFF
- Population = OFF
®  Click Run.

NOTE. Run until population crosses 2M.

The Mask Hits DPOJET measurement gives the number of Mask hits. Plug that value into the following
formula to obtain the Mask Hit Ratio:

Mask Hit Ratio = Number of Mask Hits x Signaling Speed (10.3125 ¢°) + Number of Uls (Population
from DPOJET) x Sampling Rate (50 e9)

Limits
Mask hit ratio of 5 x 10-5

Snapshot and cursor placement details

This measurement has one snapshot of the eye mask hit generated in DPOJET. No cursors are required.

See also

B QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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Voltage modulation amplitude (p-p)

134

Voltage modulation amplitude is measured as the difference between the nominal one and zero levels,
which are defined as voltages measured in the mid 20% of the high (eight 1s) and low (eight Os) regions
respectively, of the differential data signal. This test is one of the SFF-8431 Table 33 Output Specifications
at B for Cu tests.

Connect the equipment as shown in the diagram Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

For compliance, perform signal validation for 8180 (see page 114).

Measurement procedure

The voltage modulation amplitude (p-p) measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Data+ and Data— after deskewing

Signal Type ("SFPPlus.SignalType")

Algorithm

Input differential PRBS waveform.
On the input waveform identify the regions with the pattern 11111111 or 00000000.
On each such pattern measure the mean voltage in the middle 20% of the pattern.

The mean voltages corresponding to the Signal High regions is taken as vHigh and the mean voltages
corresponding to the Signal Low is taken as vLow. The vHigh and vLow values are averaged across
all regions.

The required result VMA is given by, VMA = vHigh — vLow
End

Outputs from algorithm

m_SFPPlusISDB.Result]Max.Value = VMA.Maximum
m_SFPPlusISDB.CursorPos1 Ver.Value = vHigh
m_SFPPlusISDB.CursorPos2Ver.Value = vLow
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Limits

Minimum value = 300 mV

Snapshot and cursor placement details

This measurement has one snapshot with cursorl = +ve high of VMA, cursor2 = —ve high of VMA.

See also

B Oscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

Transmitter Qsq (for Cu)

Transmitter Qsq is measured on the differential data signal as the inverse of Relative Noise (RN). RN
is measured as RN = 2 X Noise (rms) + VMA. And Noise(rms) = Sq rt ( (LogicONENoise(rms)2 +
LogicZERONoise(rms) 2 ) + 2 ). This test is one of the SFF-8431 Table 33 Output Specifications at B
for Cu tests.

Connect the equipment as shown in the diagram Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

For compliance, perform signal validation for 8180 (see page 114).

Measurement procedure

The transmitter Qsq (for Cu) measurement is performed using the algorithm library.

Inputs to algorithm

®m  Differential waveform obtained on a Math channel using Data+ and Data— after deskewing
®  Signal Type ("SFPPlus.SignalType");

Algorithm

®  Input differential PRBS waveform

n

Compute VMA as given by the VMA algorithm. On the input waveform, identify the regions with the
pattern 11111111 or 00000000.
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®  On each such pattern, measure the AC RMS voltage in the 10% window where the waveform is
the flattest.

B  The AC RMS in the 11111111 regions is LevelONENoise, and that in 00000000 regions is

, . levelONEnoise “+ LevelZEROnoise” )/2
LevelZERONoise. Measure Noise (rms) as: \/(eve rowe TLeve noise” )/

2 )
RN = * Noise(rms)

B Measure Relative Noise as: VMA

The required result TxQsq is given by TxQsq =1+ RN
®  End

Output from algorithm
m_SFPPlusISDB.Result]Mean. Value = TxQsq.Mean

Limits

Minimum value = 63.1

Snapshot and cursor placement details

This measurement has two snapshots with zoom showing one full period of the 8180 pattern. The first
snapshot has cursorl and cursor2 marking the flattest region of the high part of the period. The second
snapshot has cursorl and cursor2 marking the flattest region of the low part of the period.

See also

B Oscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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Output AC Common-Mode voltage (RMS) (for Cu)

Output AC common-mode voltage is measured as the AC RMS voltage of the common-mode ((DP + DN)
+ 2) signal. This test is one of the SFF-8431 Table 33 Output Specifications at B for Cu tests.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure

The output AC common-mode voltage (RMS) (for Cu) measurement is performed using the base
oscilloscope.

1. Mathl = (Dp + Dn) + 2. Switch off channels connected to Dp and Dn.

2. Draw a histogram bounding box from top left of the oscilloscope to the bottom right and choose
Histogram Vertical.

3. Select Mathl1 as the histogram source.
4. From the Measurement menu, select Histogram Measurements > Standard Deviation.

5. Do a single step run and measure the mean value of the histogram standard deviation. This is the
measurement result.

Limits

Maximum = 12 mV

Snapshot and cursor placement details

A screen shot where the histogram on math and the standard deviation value of the histogram is visible
on the screen. The visible standard deviation value should be the value shown in the report. No cursors
are required.

See also

m_ QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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Host output TWDPc

138

NOTE. The Host Output TWDPc test is supported only on oscilloscopes that support 100 Gs/s. For
details, see Compatibility (see page 3).

TWDP is a measure of the deterministic dispersion penalty due to a particular transmitter with reference
emulated multi-mode fibers and receiver. TWDP is initially defined to characterize the performance of
a transmitter in optical links. The same concept has been extended to quantify channel performance,
especially in high-speed copper links.

This test is one of the SFF-8431 Revision 4.1 Table 33-Host Transmitter Output Specifications at B
for Cu tests.

NOTE. The TWDPc measurement is supported only on a Ch1—Ch3 combination setup of a C or D series
oscilloscope. 100 GS/s RT mode output on Ch2 and Ch4 is not available. Therefore, if Chl is not working,
the test cannot be performed successfully.

Connect the equipment as shown in the diagram at Connection Setup for Host Tests (see page 36): All
other Host tests.

Signal validation

For compliance, perform signal validation for PRBS9 (see page 113).

Measurement procedure

The Host output TWDPc measurement is performed using the algorithm library.

Inputs to algorithm

®m  Differential waveform obtained on a Math channel using Data+ and Data— after deskewing. Sampled
at 3.3 TS/s using IT mode.

m  Signal Type (“SFPPlus.SignalType”);

Algorithm
m  Input the differential waveform (sampled at 3.3 TS/s IT)
B Down sample the differential input waveform to 16 samples per UI (which is down sampling 20 times)

um  [dentify all the PRBS9 patterns in the waveform. For each PRBS9 pattern, write all points to a text file
and call the SFF8431 x WDP algorithm.
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®m  The required result TWDPc is the average value of the TWDP calculated for each PRBS9 pattern.
®  FEnd

Output from algorithm
m_SFFPlusISDB.Result] Mean.Value = Average TWDPc value

Limits

Maximum value = 10.7 dBe

See also

m  Oscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

AC Common-Mode voltage tolerance (Module)

Output AC common-mode voltage tolerance is measured as the AC RMS voltage of the common mode
((DP+DN)=2) signal. This is one of the SFF-8431 Revision 4.1 Table 16 Module Transmitter Input
Electrical Specifications at B' tests.

Connect the equipment as shown in the diagram at Connection Setup for ModuleTests (see page 39):
All other Module tests.

Signal validation

Automatic signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The
software assumes that the PRBS31 pattern is valid.

Measurement procedure
AC common-mode voltage tolerance is measured using the base oscilloscope.

1. Generate the AC common-mode waveform on Mathl = (Dp + Dn) + 2. Switch off the channels
connected to Dp and Dn.

2. Add the base oscilloscope measurement Min and Max. Choose Mathl as the source in both cases.
3. Perform a single run and read the Min and Max values.

Limits

Min (Abs(Min), Abs(Max)) > 15 V (Table 16)
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Snapshot and cursor placement details

A snapshot of the common-mode voltage is displayed on the oscilloscope.

See also

m  QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

Single-Ended input voltage tolerance (Module)

140

Single-ended input voltage tolerance is measured as the single-ended peak-to-peak input voltage for the
positive and negative data channels on a single acquisition. This test is one of the SFF-8431 Revision 4.1
Table 16 Module Transmitter Input Electrical Specifications at B’ tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests (see page 39):
Single-Ended Input Voltage Tolerance Test.

Signal validation

Automatic signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The
software assumes that the PRBS31 pattern is valid.

Measurement procedure

Single-ended input voltage tolerance is measured using base DPOJET.
®  Use DPOJET measurement name: Ampl > Cycle Pk-Pk

®  Use DPOJET settings: All default settings

Limits
For each of Dp and Dn:

Minimum =-0.3V

Maximum =4 V

Snapshot and cursor placement details

There will be two snapshots:
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A snapshot of Dp with cursors placed at maximum and minimum voltages of single-ended Pk-Pk
measurement value of Dp. Cursor values can be derived using DPOJET: Ampl > Cycle Max and
Ampl > Cycle Min for +ve and —ve peak, respectively for Dp.

B A snapshot of Dn with cursors placed at maximum and minimum voltages of single-ended Pk-Pk
measurement value of Dn. Cursor values can be derived using DPOJET: Ampl > Cycle Max and
Ampl > Cycle Min for +ve and —ve peak, respectively for Dn.

See also

B QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

Crosstalk source Rise/Fall time (20% - 80%) (Module)

Crosstalk source rise/fall time is measured as the 20% — 80% (of VMA) Rise time and 80% — 20% (of
VMA) Fall time of the differential crosstalk source introduced to the signal. This test is one of the
SFF-8431 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for ModuleTests (see page 39):
All other Module tests.

Signal validation

For compliance, perform signal validation for 8180 (see page 114).

Measurement procedure

The crosstalk source rise/fall time (20% — 80%) measurement is performed using the algorithm library.

Inputs to algorithm
m  Differential waveform obtained on a Math channel using Dp and Dn after deskewing

®m  Signal Type ("SFPPlus.SignalType")

Algorithm
®  [nput differential waveform.

®  Obtain values of vHigh and vLow as done in the VMA measurement (averaged over all the patterns
found in the waveform).

®  Find the position of rising and falling edges in the input waveform.

B On each rising edge, traverse forward until the first point crossing the upper limit (80%) is found (=
End) and traverse backward until the first point crossing the lower limit (20%) is found (= Start).
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142

On each falling edge, traverse backward until the first point crossing the upper limit (80%) is found (=
Start) and traverse forward until the first point crossing the lower limit (20%) is found (= End).

Transition time is computed as TT = (End — Start). This value is averaged across all edges.

End

Outputs from algorithm

Rise time.

®  m_ SFPPIlusISDB.Result] Mean. Value = Tr.Mean

®  m_ SFPPlusISDB.CursorPos1 Ver.Value = Risetime begin

®  m_SFPPIlusISDB.CursorPos2 Ver. Value = Risetime end

®  m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom
®  m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set

Fall time.

®  m_SFPPlusISDB.Result2Mean. Value = Tf.Mean

®  m_SFPPlusISDB.CursorPos1 Ver.Value = Falltime begin

m  m_SFPPlusISDB.CursorPos2 Ver. Value = Falltime end

®  m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom
®  m_ SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set

Limits

Target value = 34 ps

Snapshot and cursor placement details

This measurement has two snapshots: the first with cursors placed at the rise time, the second with cursors
placed at the fall time.

Rise time: Zoom to the cursor positions. Cursorl = starting point of RT of first rising edge, cursor2 =
ending point of RT of first rising edge.

Fall time: Zoom to the cursor positions. Cursorl = starting point of FT of first falling edge, cursor2 =
ending point of FT of first falling edge.

Cursor values and zoom positions are provided by the Algorithm library.

See also

B QOscilloscope Setup (see page 111)

TekExpress SFP-TX Compliance and Debug Solution



SFP-TX tests Crosstalk source amplitude (p-p differential) (Module)

B Common Test Parameters and Values (see page 52)

Crosstalk source amplitude (p-p differential) (Module)

Crosstalk source amplitude is measured as the difference between the nominal one and zero levels,
which are defined as voltages measured in the mid 20% of the high (eight 1s) and low (eight Os) regions
respectively, of the differential crosstalk source introduced to the signal. This is one of the SFF-8431
Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests (see page 39):
All other Module tests.

Signal validation

For compliance, perform signal validation for 8180 (see page 114).

Measurement procedure

The crosstalk source amplitude (p-p differential) measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Dp and Dn after deskewing

Algorithm

®  [nput differential PRBS waveform.

B On the input waveform, identify the regions with the pattern 11111111 or 00000000.
B On each such pattern, measure the mean voltage in the middle 20% of the pattern.

B The mean voltages corresponding to the Signal High regions is taken as vHigh, and the mean voltages
corresponding to the Signal Low is taken as vLow. The vHigh and vLow values are averaged across
all regions.

B The required result amplitude is given by, Amplitude = vHigh — vLow.
B End

Outputs from algorithm

®  m_SFPPlusISDB.Result] Max.Value = Amplitude.Maximum
®  m_SFPPlusISDB.CursorPos1 Ver.Value = vHigh

®  m_SFPPlusISDB.CursorPos2 Ver.Value = vLow
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Limits
Target value = 1000 mV

Snapshot and cursor placement details

This measurement has one snapshot with cursorl = +ve high of VMA, cursor2 = —ve high of VMA.

See also

B QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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Output AC Common-Mode voltage (RMS) (Module)

Output AC common-mode voltage is measured as the AC RMS voltage of the common-mode ((DP
+ DN)=2) signal. This test is one of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input
Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for ModuleTests (see page 39):
All other Module tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Output AC common-mode voltage (RMS) is measured using the base oscilloscope.
1. Mathl = (Dp + Dn) + 2. Switch off channels connected to Dp and Dn.

2. Draw a histogram bounding box from the top left of the oscilloscope to the bottom right, and choose
Histogram Vertical.

3. Select Mathl1 as the histogram source.
4. From the Measure menu, select Histogram Measurements > Standard Deviation.

5. Do a single step run and measure the mean value of the histogram standard deviation. This is the
measurement result.

Limits
Maximum = 15 mV (Table 17)

Snapshot and cursor placement details

A snapshot where the histogram on math and the standard deviation value of the histogram is visible on
the screen. The standard deviation value visible on the screen should be the value reported in the report.
No cursors are required.

See also

m_ QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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Total jitter (Module)

Total jitter, as used here, is the Level 1 definition for TJ as described in the FC-MJSQ, where TJ is the
crossing width, defined as the late time at which the BER is 10-12 minus the early time at which the BER
is 10-12, This test is one of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input Tolerance
Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests (see page 39):
All other Module tests.

Signal validation

Signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The software
assumes that the PRBS31 pattern is valid.

Measurement procedure
Total jitter is measured using base DPOJET.
m  Deskew the Data+ and Data- inputs. Compute the differential signal on Math1l = Dp — Dn.

m  Use DPOJET TJ@BER measurement on the Math signal and Skew measurement on the single ended
input signals.

DPOJET settings
B Select Tab: Select Jitter, click TJ@BER.
- Configure the source:
= Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp — Dn)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.

146 TekExpress SFP-TX Compliance and Debug Solution



SFP-TX tests Total jitter (Module)

®  Configure Tab:
= Edges: Signal Type = Data
= Clock Recovery:
= Method = PLL-Custom BW
= PLL Model = Type 11
= Damping = 700 m
- Loop BW =4 MHz
= Click the Advanced Button:
- Nominal Data Rate = ON Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
- Click OK.
= RjD;j:
For PRBS9 signal:
= Pattern Type = Repeating
=  Window length = 511 UI
= BER 1E-=12
For PRBS31 signal:
= Pattern Type = Arbitrary
=  Window length = 10 UI
= Population = 100
= BER 1E-=12
= Filters: No filters
= General: OFF
= Global:
= QGating: OFF
= Quality: OFF
= Population: OFF
®  Results Tab: In the Options menu, deselect Display Units — Absolute.
B Click Single.
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Limits

Maximum value = 0.28 Ul

Snapshot and cursor placement details

No cursors are required because total jitter cannot be shown using cursors or snapshots. Instead, zoom
a part of the waveform to see the type of waveform used for the measurement. Zoom the waveform
between time 0 and (Horizontal scale + 104). If the record length is 2M, the number of points in the
zoomed part will be 200.

See also

B QOscilloscope Setup (see page 111)

m Common Test Parameters and Values (see page 52)

Data dependent jitter (Module)

DDJ is the range (max — min) of the timing variations measured on the differential signal with a crossing
level equal to the average value of the entire waveform being measured. The waveform is averaged
sufficiently to remove the effects of random jitter and noise in the system. This test is one of the SFF-8431
Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for ModuleTests (see page 39):
All other Module tests.

Signal validation

For compliance, perform signal validation for PRBS9 (see page 113).

Measurement procedure
Data dependent jitter is measured using base DPOJET.
B Deskew the Data+ and Data- inputs. Compute the differential signal on Math1 = Dp — Dn

®  Use DPOJET DDJ measurement on the Math signal and Skew measurement on the single ended
input signals.
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DPOJET settings
®  Select Tab: select Jitter, click DDJ.
= Source configuration:

= Source = Math 1 (Chl — Chl)

Data dependent jitter (Module)

= Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

= Click Close.
B Configure Tab:
= Clock Recovery:
- Method = PLL-Custom BW
= PLL Model = Type 11
= Damping = 700 m
= Loop BW =4 MHz
= Click the Advanced button:
- Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF
= Click OK.
- RjD;j:
For PRBS9:
= Pattern Type = Repeating
= Pattern Length = 511 Ul
= BER 1E-=12
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For PRBS31:
=  Pattern Type = Arbitrary
=  Window Length = 10 Ul
= Population = 100
= BER1E-=12
- Filters: No filters
= General: OFF
= Global:
= Gating: OFF
= Quality: OFF
- Population: OFF
B Results Tab: In the Options menu, uncheck Display Units — Absolute.
B Click Single.

Limits
Target value = 0.10 UI

Snapshot and cursor placement details

No cursors are required because Data Dependent Jitter cannot be shown using cursors or snapshots.
Instead, zoom a part of the waveform to see the type of waveform used for the measurement. Zoom the
waveform between time 0 and (Horizontal scale + 104). If the record length is 2M, the number of points in
the zoomed part will be 200.

Data dependent pulse width shrinkage (Module)

150

DDPWS is measured as the difference between one symbol period and the minimum of all the differences
between pairs of adjacent edges on the Differential Signal with a crossing level equal to the average value
of the entire waveform being measured. The waveform is averaged sufficiently to remove the effects of
random jitter and noise in the system. This is a SFF-8431 Revision 4.1 Table 17 Module Transmitter Input
Tolerance Signal Calibrated at B” test.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests (see page 39):
All other Module tests.

Signal validation

For compliance, perform signal validation for PRBS9 (see page 113).
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Measurement procedure

The data dependent pulse width shrinkage measurement is performed using the algorithm library.

Inputs to algorithm

Differential waveform obtained on a Math channel using Data+ and Data— after deskewing.

Algorithm

E  [nput differential waveform.

B Estimate the Ul of the waveform (UI = bit duration). Identify the Edges on the input waveform.

B Consider a Cycle of PRBS 9 pattern. (A cycle contains 511 bits or 256 edges). Identify the lowest Ul
in the cycle (for example, the lowest time duration between adjacent edges in a cycle). Average this
minimum value across multiple cycles of PRBS9 present in the input waveform. (In the case of a non
PRBS 9 waveform being used, consider all the edges and Uls in the waveform as a single cycle.)

®  Compute Data Dependent Pulse Width Shrinkage (DDPWS) as: DDPWS = Estimated Ul — minimum
UL

B End

Outputs from algorithm

®  m_SFPPlusISDB.Result] Mean.Value = DDPWS.Mean

B m_ SFPPlusISDB.CursorPos1 Ver.Value = beginning of smallest Ul

B m_SFPPlusISDB.CursorPos2 Ver.Value = end of smallest UL

®  m_SFPPlusISDB.HorizontalPos1.Value = position of the waveform where to zoom
®  m_SFPPlusISDB.HorizontalScalel.Value = scale of Zoom that is to be set

Limits

Target value = 0.055 Ul

Snapshot and cursor placement details

This measurement has one zoomed snapshot with cursorl and cursor2 marking the smallest UI.

See also

B QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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Uncorrelated jitter (Module)

152

Uncorrelated jitter refers to the component of jitter in the transmitted signal that is not correlated to the
transmitter data. The uncorrelated jitter (rms) is given by the RMS value of the standard deviations of
the two distributions, namely standard deviation of jitter on rising edge and standard deviation of jitter
on falling edge. This test is one of the SFF-8431 Table 17 Module Transmitter Input Tolerance Signal

Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests (see page 39):
All other Module tests.

Signal validation

For compliance, perform signal validation for PRBS9 (see page 113).

Measurement procedure

The uncorrelated jitter measurement is performed using the algorithm library.

Inputs to algorithm
m  Differential waveform obtained on a Math channel using Data+ and Data- after deskewing

m  Signal Type ("SFPPlus.SignalType")

Algorithm
B [nput differential waveform.

®  Identify the deviation of each rising and falling edge on the input signal from its ideal location
(constructed using Ul = 1+ data rate) (Note: consider the rising and falling edges of a pattern with the
longest run of 1s to maintain some uniformity on the edges to measure deviations. If the deviations
were measured on all edges, then the deviations are inconsistent for different edges resulting in
measurement errors.)

B Find the standard deviation of the deviations of the rising edges. Find the standard deviation of the
deviation of the falling edges.

[2 2
=vN(o,+ o )12

where o, is the standard deviation of the jitter on the rising edge

®  Compute UJ as follows:

Uncorrelated jitter (rms):

where o is the standard deviation of the jitter on the falling edge

® FEnd
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Output from algorithm
m_SFPPlusISDB.Result]Mean. Value = UJ.Mean

Limits
Target value = 0.023 Ul

Snapshot and cursor placement details

No cursors are required. Uncorrelated jitter cannot be shown using cursors or snapshots. Zoom a part of
the waveform to see the type of waveform used for the measurement. Zoom the waveform between time 0
and (H-scale = 104). If the record length is 2M, the number of points in the zoomed part will be 200.

See also

m Oscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)

Eye mask hit ratio (Module)

The required transmitter pulse shape characteristics are specified in the form of a mask of the transmitter

eye diagram (used to measure the number of Mask Hits). Eye Mask hit ratio is computed using Eye Mask
hit ratio = (Number of Mask Hits x Signaling Speed) + (Number of Uls x Sampling rate). This test is one
of the SFF-8431 Revision 4.1 Table 17 Module Transmitter Input Tolerance Signal Calibrated at B” tests.

Connect the equipment as shown in the diagram at Connection Setup for Module Tests (see page 39):
All other Module tests.

Signal validation

Automatic signal validation for PRBS31 pattern signals is not done by the SFP-TX application. The
software assumes that the PRBS31 pattern is valid.

Measurement procedure
Eye mask hit ratio is measured using base DPOJET.
®  Deskew the Data+ and Data— inputs. Compute the differential signal on Mathl = Dp — Dn.

®  Use DPOJET Mask Hits measurement on the Math signal and Skew measurement on the single-ended
input signals.
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DPOJET settings
Select Tab: Select Eye >Mask Hits.

Configure the Source:

Eye mask hit ratio (Module)

Click the arrow button in the Source(s) column and configure Source 1 = Math 1 (Dp—Dn)

Select the Advanced check box and then set Reference Level % relative to Base Top as

follows:
Setting Rise Fall
High 80% 80%
Mid 50% 50%
Low 20% 20%
Hysteresis 5%

Click Close.

Configure Tab:

Edges: Signal Type = Data

Clock Recovery:

Method = PLL — Custom BW

= PLL Model = Type 11

= Damping =700 m

= Loop BW =4 MHz

Click the Advanced button:

= Nominal Data Rate = ON. Bit Rate = 10.3125 Gb/s
= Known Data Pattern = OFF

- Click OK.

Click Apply.

RjD;:

For

PRBSO9 signal:

= Pattern Type = Repeating
= Pattern Length = 511 UI
= BER 1E-=12
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For PRBS31 signal:
= Pattern Type = Arbitrary
=  Window length = 10 UI
= Population = 100
- BER 1E-=12
= Filters: No filters
= General: OFF
= Global:
= QGating = OFF
= Quality = OFF
- Population = OFF
®  Click Run.

NOTE. Run until population crosses 2M.

The Mask Hits DPOJET measurement gives the number of Mask hits. Plug that value into the following
formula to obtain the Mask hit ratio:

Mask Hit Ratio = Number of Mask Hits x Signaling Speed (10.3125 ¢9) + Number of Uls (Population
from DPOJET) x Sampling Rate (50 e9)

Limits
Mask hit ratio of 5 x 10-5

Snapshot and cursor placement details

This measurement has one snapshot of the eye mask hit generated in DPOJET. No cursors are required.

See also

B QOscilloscope Setup (see page 111)

B Common Test Parameters and Values (see page 52)
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De-embed using filter files

TekExpress SFP-TX provides an option to de-embed the signal path using filter files. You create the filter
files. The filter files are .flt files composed of de-embed filter coefficients for a particular sampling rate.

A filter file created for one sampling rate might not work for other sampling rates, so it is important to
understand at what sampling rate the measurements are being performed. The following table summarizes
the sampling rates used for each measurement.

Table 18: Measurement sampling rates

Measurement Oscilloscope model
DPO/DSA/MSO A & B DPO/DSA/MSO C Series
Series
Input on any channel Input on Ch1 and Ch3 Input on Ch2 and Ch4
combination
Single-Ended Output 50 GS/s 100 GS/s 50 GS/s

Voltage Range
Output AC Common Mode

Voltage (RMS)
Host Transmitter Jitter and Eye Mask specifications
Crosstalk Source Rise/Fall 50 GSI/s 100 GS/s 50 GS/s

Time (20% — 80%)
Crosstalk Source
Amplitude (p-p differential)

Signal Rise/Fall Time (20%
- 80%)

Total Jitter (p-p)

Data Dependent Jitter
(p-p)

Data Dependent Pulse
Width Shrinkage (p-p)

Uncorrelated Jitter (RMS)
Transmitter Qsa

Eye Mask Hit Ratio
Host Transmitter Output Specifications for CU (SFP+ Host supporting direct attached cables)
Voltage Modulation 50 GSI/s 100 GS/s 50 GS/s

Amplitude (p—p)
Transmitter Qsa

Output AC Common Mode
Voltage

Host Output TWDPc Not applicable 3.3TS/s Not applicable
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Deskew channels

See also

B Common Test Parameters and Values (see page 52)

®  Configure Tests (see page 51)

Deskew channels

158

If skew is present between positive and negative channels, then the channels need to be deskewed before
being used for waveform measurements. TekExpress SFP-TX provides support for channel deskew
using the following method:

1.
2.
3.

8.
9.

Determine what the skew is for each channel.
From the TekScope menu, select Vertical > Deskew.

In the Deskew/Attenuation window, click the channel (1 — 4) button for the first channel to be
deskewed.

Click in the Ch(x) Deskew Time entry field and enter the skew. The skew can be +ve or —ve.
Click the channel button for the next channel and repeat step 4.

After entering the skew for all the channels that require it, from the Options menu in TekExpress
SFP-TX, select Deskew.

In the Deskew dialog box, select the desired level:

= Less than 100 mV signal amplitude: Select this if the signal amplitude is such that the
oscilloscope’s vertical setting is less than 100 mV/division.

= 100 mV or greater signal amplitude: Select this if the signal amplitude is such that the
oscilloscope’s vertical setting is greater than 100 mV/division.

Click Read Deskew/Attn.

When the status in the dialog box indicates the deskew is finished, click Close.

Each input channel has its own deskew settings. Deskew compensates individual channels for probes or
cables of different lengths. The instrument applies the delay values after each completed acquisition. The
deskew values are saved as part of the instrument setup. The deskew values for the selected channel are
retained until you change the probe, you restore a saved setup, or you recall the factory setup.

See also

B Select Acquisitions (see page 46)

m PreRun Checklist (see page 61)
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Map the My TekExpress folder

Follow these steps to map the My TekExpress folder on the instrument:
1. Open Windows Explorer.

2. From the Windows Explorer menu, click Computer.

3. In the menu bar, select Map network drive.
4

Select the Drive letter as X: (if there is any previous connection on X:, disconnect it first through
Tools > Disconnect Network drive menu of Windows Explorer. Windows 7 users: if you do not see
the Tools menu, press the Alt key).

5. In the Folder field, enter the remote My TekExpress folder path (for example, \\192.158.97.65\
My TekExpress).

To determine the IP address of the instrument where the My TekExpress folder exists, do the following:
1. On the instrument where the My TekExpress folder exists, click Start and select Run.
2. Type “cmd” and then press Enter.

3. At the command prompt, type “ipconfig” and then press Enter.

See also

®  Before You Click Start (see page 59)

E Install the Software (see page 5)
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